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Chapter 1  

Introduction 

The Content Author’s Cookbook is designed to give content authors the information they 
need so that they can use Sitecore CMS to perform their day to day work. This cookbook 
is primarily aimed at introducing new content authors with limited computer skills to the 
tools that Sitecore contains. However, the procedures described in this document will 
also be beneficial for more experienced and technically skilled content authors who are 
unfamiliar with the tools that Sitecore contains. 

Content authors must be able to update existing content on their corporate website or 
intranet as well as create new material. This cookbook explains how to perform both 
these tasks with the two editing tools that Sitecore contains — the Page Editor and the 
Content Editor — and demonstrates how to edit existing items and create new items with 
both of these tools. The cookbook also introduces some of the more advanced features 
and functionality that Sitecore contains. 

This Content Author’s Cookbook contains the following chapters: 

 Chapter 1 — Introduction 
This chapter is a description of the content, aims, and the intended audience of this 
manual.  

 Chapter 2 — Sitecore 
This chapter is an introduction to basic Sitecore functionality including item locking and 
formatting. 

 Chapter 3 — Managing Content in the Page Editor 
Step by step instructions for using the Page Editor to create and edit content. 

 Chapter 4 — Managing Content in the Content Editor 
Step by step instructions for using the Content Editor to create and edit content. 

 Chapter 5 — The Rich Text Editor 
Step by step instructions for editing text and links using the Rich Text Editor. 

 Chapter 6 — Item Buckets 
Step by step instructions for creating and using Item Buckets. 

 Chapter 7 — Searching in Sitecore 
Step by step instructions for using the search functionality in Sitecore. 

 Chapter 8 — The Media Library 
Step by step instructions for using the Media Library. 



Sitecore CMS 7.1 Content Author's Reference and Cookbook  

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of 
this document are the property of Sitecore. Copyright © 2001-2013 Sitecore. All rights reserved.  

Page 7 of 188 

 Chapter 9 — RSS Feeds 
Step by step instructions for creating RSS feeds. 

 Chapter 10 — Workflows for Content Editors 
Step by step instructions for creating and using workflows. 

 Chapter 11 — Customizing the Interface 
Step by step instructions for customizing the Sitecore interface. 
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Chapter 2  

Sitecore 

This chapter introduces some of the basic Sitecore functionality. This chapter explains 
how to log in, how item locking works, and describes how roles affect the functionality 
that is available to you in Sitecore CMS. 

This chapter contains the following sections: 

 Logging In 

 Roles and Functionality 

 Item Locking 

 Formatting 
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2.1 Logging In  

You must log in to Sitecore before you can edit any of the content on a website. 

To log in to Sitecore:  

1. Enter Sitecore after the name of your website, for example 
http://www.mywebsite.net/sitecore and the Log in page appears. 

 

2. Select the user interface that you want to use, enter your user name and password, and click Log 
in to log in and to start working on the website. 

Note 
There are no applications available from the Launch Pad until you have manually installed them. 

Configuring Sitecore on Internet Explorer 

If you have any problems configuring your Sitecore client on Internet Explorer, see the Internet Explorer 
Configuration Reference manual.  
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2.2 Roles and Functionality 

Sitecore contains tools that are suited to both experienced and inexperienced content authors. The 
Content Editor is the editing tool for experienced users. However, depending on the roles you have been 
assigned, the functionality that is available to you may differ from the functionality described in this guide. 

For example, a user who has been assigned one set of roles may see the following ribbon in the Content 
Editor. 

 

While a user who has been assigned another set of roles may see much more functionality in the 
Content Editor ribbon. 

 

Furthermore, when you log in to the Sitecore Desktop, the set of applications shown in the Sitecore menu 
also depends on the roles that have been assigned to you. The following screenshots show the Sitecore 
menu for two users with different sets of roles: 
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2.3 Item Locking 

Sitecore uses item locking to ensure that two different users cannot edit the same item at the same time.  

Note 
A content administrator might have the authority to edit another user’s locked items. So if it happens that 
a content administrator and another user manage to edit the same item simultaneously, only the changes 
that are made by the user who clicks Save last will be available. If a user saves changes to an item, and 
another user saves changes to the same item afterwards a message box does appear, asking if the user 
wants to overwrite previously saved changes to the item. 

You lock the item that you are editing to prevent other users from editing this item at the same time. You 
unlock it again after you have finished editing the item.  

Item locking works differently depending on the tools that you are using: 

 In the Page Editor, you can lock an item before you start to edit it.  

 In the Content Editor, you must lock an item before you can edit it. 

2.3.1 Item Locking and Publishing 

Be aware that locking an item does not keep it from being published. If you are working on an item and 
you want to keep it from being published you need to set the publishing restrictions for the item. This can 
only be done from the Content Editor. 

To restrict an item from being published: 

1. In the content tree, navigate to the item you want to restrict from publishing. 

2. Click the Publish tab and, in the Restrictions group, click Change to open the publishing 
settings for the item. 

3. Clear the Publishable check box for the version of the item that you do not want published and 
click OK. 
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2.4 Formatting 

In Sitecore, the formatting of the content that is displayed on a website is generally controlled by the style 
sheets that have been defined for the website by the administrators, designers, programmers, and so on. 

This means that as a content author, you do not have to worry about how the material you are 
responsible for is presented to the reader and can concentrate on the quality of the material.  

You can influence the style by making some text bold or italic and so on. Furthermore, if you know how to 
write HTML code, you can edit the code and thereby influence the way that the content is presented. In 
general, you can concentrate on the material that is presented and ignore the way that it is formatted. 
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Chapter 3  

Managing Content in the Page Editor 

This chapter introduces the Page Editor and the functionality it contains. It contains 
detailed descriptions of how to edit an existing item including how to edit simple text fields 
and rich text fields. There is a description of how to manage images in the Page Editor. 
There are also detailed instructions on how to create new items. 

This chapter contains the following sections: 

 The Page Editor 

 Editing an Item in the Page Editor 

 Searching in the Page Editor 

 Previewing Pages 

 Creating a New Item in the Page Editor 

 Deleting Content 
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3.1 The Page Editor 

Content authors are generally focused on the quality and accuracy of the material displayed on the 
website rather than on the design, style, and layout of the site. For this reason most content authors 
prefer to work in a program that is designed to meet their needs rather than those of the developers and 
designers who create the websites. 

With this mind, Sitecore CMS allows content authors to edit and create items directly on the web page 
with the Page Editor. The Page Editor is the simplest of the editing tools that Sitecore provides. It is 
designed for inexperienced content editors who edit and write content items directly on the page. It is a 
WYSIWYG editor (what you see is what you get) that allows you to see the changes that you make 
directly on the page. Furthermore it limits the amount of functionality that is presented to the user. 

When you log in to the Page Editor, the functionality that is available to you vary, depending on the 
security roles that you have been assigned and the customizations that have been carried out on the 
website that you are accessing. 

When you log in to the Page Editor, the ribbon is displayed at the top of the web page. If you have been 
given full access to all functionality in the Page Editor, you have access to all five tabs in the ribbon, each 
with its own collection of commands.  

 

As a minimum, you can expect to see the buttons shown in the following screenshot at the top of the web 
page. 

 

Regardless of the ribbon that you use, there is always a Save button in the top-left corner. 

When you are editing an item, you can click the Toggle Ribbon button  to temporarily hide the ribbon 
to give yourself some more space to work with or to view a less confusing layout. Click the Toggle 
Ribbon button  again to display the ribbon.  
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3.2 Locking Items in the Page Editor 

Depending on your access rights and the setup of items you have the following options to lock items 
before editing the content in the Page Editor.  

3.2.1 Locking in the Limited Page Editor 

If you have access to the Limited Page Editor, you can edit an item directly on the page without locking it. 
When you save the item, Sitecore locks it for you. If the item that you want to edit is already locked, you 
cannot edit it, you can only navigate. 

You can click Lock to manually lock an item before editing it.  

 

When you lock an item, it is noted in the My Items button on the ribbon. In the following screenshot, the 
user has locked one item:  

  

When you have finished editing the item, remember to unlock it so that other users can edit it. 

3.2.2 Locking in the Minimal Page Editor 

If you only have access to the Minimal Page Editor, you do not have access to the ribbon and therefore 
you cannot manually lock an item before you edit it. If the item that you want to edit is already locked, you 
cannot edit it, you can only navigate.  

 

If two editors with the same minimal access rights edit the same item, the editor who saves the item last is 
notified that changes have been made to the item and asked if the changes should be overruled. 
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3.3 Unlocking Items in the Page Editor 

Once you are done editing the content in the Page Editor, you must remember to unlock the items that 
you have locked so that other users can edit them.  

3.3.1 Unlocking in the Limited Page Editor 

To unlock an item via the ribbon, select the item and click Lock.  

If you have locked and edited numerous items, and maybe lost track of them all, you can see which items 
are locked by you if you click My Items in the Edit group. 

 

The My Items dialog box lists all of the items that you have locked.  

To unlock one or more items select them and click Unlock. To unlock all the items, click Unlock All. 
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3.4 Editing an Item in the Page Editor 

The Page Editor is designed for content authors who want to do their editing directly on the page.  

The Page Editor is a WYSIWYG editor that allows you to see the changes that you make directly on the 
page. This helps the inexperienced users to control the changes that they make to the content items that 
they are responsible for. 

In the Page Editor, you can edit: 

 Simple text fields — multi-line text fields, date fields and link fields. 

 Rich text fields — fields that you edit in the Rich Text Editor. 

 Word fields — fields that you edit in Microsoft Word. 

 Media items — any kind of graphical item or sound file. 

In the Page Editor, you can edit not only the fields of the current item, but also the fields of any items 
rendered on the page. For instance, if the menu on the page consists of titles of the product items, you 
can edit the titles without navigating to the product items themselves.  

 

3.4.1 Editing a Simple Text Field 

To edit a simple text field: 

1. Log in to the Page Editor. 

2. Navigate to the item that you want to edit. 
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3. In the item, select a simple text field that you want to edit.  

 

4. Edit the text directly on the page. The text field automatically expands to fit the text you enter.  

5. When you are finished editing the text, you can start editing another text block or click Save to 
save the changes and exit editing mode. You can also click Close to close the item. If you have 
made any changes on the page, you will see the following prompt dialog box:  

 

3.4.2 Editing a Rich Text Field Directly on the Page 

A rich text field gives you more control over how the text appears on the web page. 

To edit a rich text field: 

1. Click a rich text field and Sitecore displays your options in a floating menu. 

 

Note 
The options available in the floating toolbar vary depending on which version of Sitecore CMS 
you have running and your access rights. 
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2. To edit the text in the Rich Text Editor, click the Edit Text button . For more information about 
the Rich Text Editor, see the section The Rich Text Editor. 

3. To edit the text directly on the page, just click the line that you want to edit and start typing.  

When you edit a rich text field directly on the page, you can not only edit the text but also format 
it. You can make the text bold, italic, and underlined, or insert a link or an image. 

Inserting a Link 

To insert a link into a rich text field: 

1. Select the text that you want to use as a link and click the Insert Link button . 

 

2. In the Insert a Link dialog box, you can find the item that you want to link to by: 

o Navigating through the content tree on the Internal Link tab. 

o Navigating through the Media Library on the Media Items tab to link to an image or media 
file. 

o Searching for the item on the Search tab.  

 

For more information about the Sitecore search functionality, see the section Searching in 
Sitecore. 

3. When you have found the item that you want to link to, click Link. 
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Inserting an Image 

You can insert various types of media into the item. These could be animations, film clips, sound files, 
and so on. 

To insert an image into the rich text field that you are editing: 

1. Click the Insert Image button . 

 

The Insert Media Item dialog box opens. 
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2. Navigate through the content tree on the Media Library tab and choose the image or media item 
that you want to insert. You can also click the Search tab and search for the item. 

 

For more information about the Sitecore search functionality, see the section Searching in 
Sitecore. 

3. Click Insert to insert the image into the rich text field. 

Uploading an Image or File 

If the media file that you want to use is not available in the Media Library, you must upload it to the Media 
Library. 

To upload an image or file to the Media Library: 

1. In the Page Editor, click the Insert Image button . 
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Sitecore opens the Insert Media Item dialog box. 

 

2. In the Insert Media Item dialog box, click Upload to open the Upload a File dialog box. 

 

3. In the Upload a File dialog box, click Browse to locate the file that you want to use. Select the 
file and click Open to upload the item to the Media Library. 
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4. Sitecore opens the Content Editor, from where you must lock the item before you can edit the 
item and save it. 

 

5. Exit the Content Editor to return to the Insert Media Item dialog box. Now you can choose the 
item that you just uploaded and click Insert to create a link to the new item. If you click Cancel, 
the Insert Media Item dialog box closes, but the new item remains available for later use. 
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3.4.3 Editing a Rich Text Field in the Rich Text Editor 

You can also edit rich text fields in the Rich Text Editor. 

1. Select the rich text field that you want to edit. 

 

2. Click Edit Text  to open the text in the Rich Text Editor.  

 

3. In the Rich Text Editor you can: 

o Insert and delete links to other parts of the website and to external websites. 

o Insert pictures or other media items. 

o Insert symbols into the text. 

o Paste text from Microsoft Word into the item.  

o Find and replace text in the item. 

4. If you prefer editing the text in HTML format, click the HTML button to view and edit the item in 
that format. 

5. Click Accept to save your changes and close the Rich Text Editor. 

For more information about using the Rich Text Editor, see the section The Rich Text Editor. 

Note 
Your Sitecore system administrator controls the functionality that is available in the Rich Text Editor. If 
you need more functionality, ask your administrator to make it available to you. 
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3.4.4 Editing a Word Field in the Page Editor 

Sitecore also supports using Microsoft Word as a text editor. People who are familiar with Word may 
prefer using this tool to edit lengthy pieces of content. These Word fields are defined in the template by 
the developer who creates the website. Consequently, you only come across Word fields if a developer 
sets them up in the template. 

Important 
You must have Microsoft Word 2007 or later installed on your computer to edit Word fields in Sitecore. 

Sitecore Word fields are only supported on Internet Explorer 7 and later. 

Configuring Word Fields 

If you are using Internet Explorer 8, the first time you access a Word field in Sitecore, you will receive an 
error telling you that your security settings will not let you run ActiveX controls on the page. 

 

If this is the case, you must configure Internet Explorer to support Word fields in Sitecore. 

To configure Internet Explorer to support the Word fields: 

1. Ensure that you only have one instance of Internet Explorer open. 

2. In Internet Explorer, click Tools (ALT+T), and then click Internet Options.  

 

3. In the Internet Options dialog box, click the Security tab, and then click Trusted Sites. 
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4. In the Security level for this zone section, click Custom level, and the Security Settings - 
Trusted Sites Zone dialog box appears. 

 

5. In the Security Settings - Trusted Sites Zone dialog box, in the Settings section scroll down to 
the ActiveX controls and plug-ins node. 

6. In the Automatic prompting for ActiveX controls section, click Enable. 

7. Click OK to accept the changes that you made. 

Now when you access a Word field in Sitecore, you are prompted to install an ActiveX 
component. 

 

8. Click Install to install the component. 

When the component is installed, you can edit the field in Word. 

Note 
After you have installed this ActiveX component, you should consider undoing these changes and going 
back to the original security settings. 
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Editing a Word Field 

To edit a Word field in the Page Editor: 

1. In the Page Editor, move the mouse over a Word field and it displays a small Word icon. 

 

2. Click Edit the word document  to open a new window that displays the content of this field in 
Word. You have access to all the functionality that Word contains.  

 

o To insert a Sitecore link to another item on your website, click Insert Link. 

o To insert an image from the Media Library, click Insert Media. 

o To insert an image that is not in the Media Library, use Word’s functionality. 

o You should upload any images that you want to use regularly to the Media Library. 
 

3. Click Accept to save the changes you have made, and close the window. 

4. To close the window without saving your changes, click Reject. 

5. In the Page Editor, save your changes and unlock the item. 
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Depending on how your website has been configured, you can also edit Word fields directly on the page. 
If your website supports inline editing, all of the functionality of Word is available in the inline editing pane. 

 

When you are editing a Word field inline, you see the following additional buttons: 

 Display Ribbon  

To display or hide the ribbon in Word, click Display Ribbon. 

 Insert Link  

To insert a Sitecore link to another item on your website, click Insert Link. 

 Insert Image  

To insert an image from the Media Library, click Insert Image. 

For more information about configuring Word fields, see the Presentation Component XSL Reference 
manual. 

3.4.5 Editing a Media Item 

You can also use the Page Editor to edit any media items that are displayed on the website. When you 
select an image, you are presented with some additional options. Note that the options that are available 
to you vary depending on the installation and your access rights. 

 

You can: 

 Select the image to be displayed. 

 Modify the appearance of the image 

 Remove the image. 
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Editing the Link in an Image 

You can only edit links on images placed in Rich Text or Word fields, and only if you open the text editor. 

From either the Rich Text Editor or the Word Editor you can: 

 Change the link by inserting a new one. 

 Remove the link. 

To change the link in an image: 

1. If the image is a link, click Insert Sitecore Link.  

The Insert a Link dialog box opens on the Media Items tab. 

 

2. Click the Search tab to search for the content item you want to link to.  

 

For more information about the Sitecore search functionality, see the section Searching in 
Sitecore. 

3. If you want to link to a media item, click the Media Items tab and navigate through the media 
items tree.  

4. If you want to link to a page on your website, click the Internal Link tab, and navigate through the 
content tree. 

Note 
You can only link to another item in this website and not to another website. 
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5. Click Link. 

Changing the Image 

To change the image that is displayed in the image field: 

1. In the Page Editor, select the image field with the image that you want to change.  

2. Click the Choose an Image button  to open the Select Media dialog box. The Select Media 
dialog box opens and displays all the items from the Media Library that is available for the image 
field you have chosen. 

 

Note 
The items are not listed in any particular order in the Select Media dialog box, so use the search 
functionality or the pre-defined lists from the menu to find a particular item. 

3. In the Media menu you can use the links to quickly get a complete list of: 

o All image files 

o All video files 

o My images – this lists all the image files that have been updated by the current user. 

o Recently uploaded images 

o Recently uploaded videos 

4. To filter the displayed media items according to the images’ metadata, click the Filter drop-down 
button and select the appropriate filters. The number in parenthesis indicates how many items are 
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available for the filter. 

 

5. If you want to search for a specific item, enter a search word in the Search field. 

6. Click  Upload media to upload a new media item to the library. 

7. If you want to navigate through the content tree to find the image that you want to use, click the 

Tree View button  in the upper right corner of the Select Media dialog box. This displays the 

Media Library in a content tree. To go back to the list view, click the List view button  

 

8. Select the image that you want to use, click Select Media, and the new image is inserted into the 
image field. 

Uploading an Image 

If the image you want to use is not available in the Media Library, you can easily make it available by 
uploading it to the Media Library. 

To add an image to the Media Library: 

1. In the Content pane, click Browse to open the Select Media dialog box. 
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2. Click  Upload media to upload a new media item to the library. 

 

3. To add the new media items to the Upload Media dialog box, you can: 

o Click Browse for media files to navigate to the image that you want to add to the Media 
Library.  

o Drag and drop the images directly into the Upload Media dialog box.  

4. Add as many media items to the Upload Media dialog box as you need and be sure to enter the 
appropriate name, description, and alternate text for each new media item. 

5. When all the necessary media items have been added, click Upload media. 

6. When the upload is completed, click Back to go back to the Select Media dialog box.  

The image is now uploaded to the Media Library and you can use it on your website. 

Modifying the Image Appearance 

To modify the image appearance: 

1. In the Page Editor, select the image. 

2. Click Modify Image Appearance to open the Image Properties dialog box. 

 

3. In the Alternate Text field, enter the text to be displayed when you move the mouse over the 
image. 

4. In the Dimensions section, specify the dimensions that the image should be displayed in — if 
they differ from the actual size of the image. 
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5. In the Space section, specify in pixels how much space should be placed around the image. 
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3.5 Searching in the Page Editor 

In the Page Editor you can use the search functionality to search for a specific item and then redirect the 
Page Editor to that item. Also, if you are working on multiple websites, you can use the search 
functionality in the Page Editor to quickly move from one site to another.  

 

To redirect the Page Editor to a specific item using search: 

1. In the Page Editor, click the Search icon in the menu of the Page Editor and the Navigate to 
Item dialog box opens.  

An automatic search is run for all items across all your Sitecore sites, so the Navigate to Item 
dialog box displays a list of all the items that exist on your websites. 

2. Narrow down the search to find the item.  

3. Select the item that you are interested in from the list of search results and click OK. 

Note 
The search functionality is also available when the Page Editor is in preview mode. 

For more information about the Sitecore search functionality, see the section Searching in Sitecore. 
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3.6 Previewing Pages 

You can preview the website without publishing.  

3.6.1 Previewing the Pages in the Page Editor 

The Preview application supports the ability to specify a preview date, which allows you to view the site in 
the past or future, based on the publishing restrictions as they are currently set. Moreover, in the Preview 
mode you can see how the page looks in different language versions and how the page is displayed for 
different devices. 

1. In the Page Editor, in the Mode group, click Preview. 

2. On the Experience tab, select preview parameters (Date and Language). This tab might not be 
available to you if you don’t have enough security permissions. 

3. Navigate through your website to preview the pages. 

3.6.2 Previewing the Pages in the Device Simulator 

The Device Simulator enables you to preview your website in a simulation of several different devices, 
such as an iPhone, iPad, Android Phone, and Blackberry. 

The device simulator mimics the devices and the preview is not a pixel-perfect rendition of the website as 
it appears on each device. However, it gives you a good indication of how the device presents the 
website and allows content authors to quickly see how their pages look on mobile devices. 

To preview a page in the Device Simulator: 

1. On the Experience tab, in the Mode group, click Preview. 

2. In the Simulator group, click the drop-down arrow and select a device. 
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All the navigation in the simulation remains fully functional.  

 

3. Click Services to go to the Services page. 

 

In the Device Simulator you can:  

o Click Rotate to change the orientation of the device. 
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o Scroll up and down as well as left and right. 

4. Click None to close the simulation and return to the default page preview,  
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3.7 Creating a New Item in the Page Editor 

As a content author, you can create new content items and insert them into the web page where you want 
them displayed. 

The ways in which you can create items in Sitecore can vary depending on the security roles that you 
have been assigned and the way your website has been customized. 

3.7.1 Inserting Items  

To insert a new item onto the page in the Page Editor: 

1. Navigate to the page that you want to edit. 

2. Click the Edit button at the top of the page. 

3. On the ribbon, click Insert Page to open the Insert Page dialog box. 

 

The type of item that you can create varies depending on where you are on the website. If you 
are on the front page, you can insert a new section and, depending on the type of section that 
you are working with, you can add appropriate items to that section. 

4. Select the type of item that you want to insert. In this example, you insert a new section. 

5. In the Item Name field, enter the name of the section that you want to insert. 

6. Click Insert to create the new section and the section is added to the website and as you can 
see, the new section contains no items. 
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When you create a new item, it is automatically locked to prevent other users from editing it. 

 

7. Now you can edit the item by adding text, images, sidebar text, and so on. 

8. When you are finished editing the new item, click Save and then Unlock to make the item 
available to other content authors. 

For more information about unlocking items, see the section Unlocking Items in the Page Editor. 
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3.8 Deleting Content 

Content authors also need to delete items and content from time to time. This is a very simple task in the 
Sitecore Page Editor. 

3.8.1 Deleting an Item 

To delete an item from the Page Editor: 

1. Navigate to the item that you want to delete. 

If you want to delete an item, navigate to that item. 

If you want to delete a subitem, navigate to the subitem in question and not just the link to it that 
is shown on another item. 

2. On the ribbon, click Delete Page to remove the item or section. 

Once again, depending on the customizations carried out on your website and the way the Page 
Editor has been configured, the Delete Page button may be located on the ribbon or at the top of 
the screen. 

3. If you try to delete an item that contains subitems, a message appears informing you that that the 
section contains subitems and that these items will be deleted along with the section.  

 

4. If you want to save any of the items, click Cancel and then move them to another section. 

5. Click OK to delete the item and its subitems. 
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Chapter 4  

Managing Content in the Content Editor 

This chapter introduces the Content Editor and the functionality it contains. It contains 
detailed descriptions of how to edit existing items. There is also a description of how to 
manage images in the Content Editor. There are detailed instructions on how to create 
new items and how to delete items. 

This chapter contains the following sections: 

 The Content Editor 

 Editing an Item in the Content Editor 

 Creating New Items in the Content Editor 

 Deleting Items in the Content Editor 

 Archiving 

 Cloning Items 

 Setting Reminders 
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4.1 The Content Editor 

The Content Editor has been designed for more experienced content authors who are familiar with 
Sitecore and the functionality that it contains. 

The Content Editor is a large application but its appearance and the functionality that it contains varies 
depending on the roles that have been assigned to the user, the local security settings, and the amount of 
customizations that have been carried out on your installation. 

The Content Editor gives the user access to an array of functionality that meets the needs of the more 
experienced content author.  

The functionality that you have access to in the Content Editor can vary greatly. As a minimum you can 
expect to see: 

 

If you have been given more extensive access rights, you will probably have access to more commands 
and more tabs: 

 

If you have complete access to the Content Editor, it will look something like this: 

 

4.1.1 The Page Editor vs. the Content Editor 

When you log in to the Content Editor, the items that make up your website are presented to you in a very 
different way than they are in the Page Editor. In the Page Editor, you see the items as they are 
presented on the website. In the Content Editor, you see the items as objects in the content tree and 
when you select an item, it is presented to you as a list of fields that you can edit. 



Sitecore CMS 7.1 Content Author's Reference and Cookbook  

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of 
this document are the property of Sitecore. Copyright © 2001-2013 Sitecore. All rights reserved.  

Page 44 of 188 

For example, the Services section of the sample website looks like this in the Page Editor: 

 

You can edit all of the items that appear on the page — text, graphics, logos, links, and so on. 

When you open the Services section in the Content Editor, it looks like this: 
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As you can see, it is presented as a list of fields that you can edit. Furthermore, the fields that you are 
presented with are only those that belong to the Products item itself. The Services item, the Home-
Services item, and so on are all separate items and must be edited independently of each other in the 
Content Editor. In the Page Editor, you are presented with the web page as you see it on the website and 
you can edit almost every page element even if it does not belong to the current item. 

4.1.2 The Content Tree 

One of the main features of the Content Editor is the content tree that is used to present all the items that 
have been created for the website. 

 

The Sitecore content tree has a similar structure to the one used in Windows Explorer. In Sitecore, 
objects and groups are not represented by standard folder and file icons but by many different icons. You 
can expand and open every group in the Sitecore content tree just as you can with the folders in Windows 
Explorer. When there is a plus ‘+’ beside an icon, it contains subitems and can be expanded. When there 
is a minus ‘-’ beside an icon, it has already been expanded and when there is no symbol, the item 
contains no subitems. 

4.1.3 Searching From the Content Tree 

If you want to do a quick and simple search through the Content Tree, you can use the search function 
associated with the Sitecore content tree.  

To search for an item using the Content Tree search: 

1. In the content tree, select the object that you want to search from. This is the starting point for 
your search. 

The Sitecore search engine searches the entire content tree. However, the search results found 
after this starting point is listed first.  

2. In the Search field, enter the keyword that you want to search for. This can be any character, 
number, word, and so on. 

3. Click Search  or press ENTER to perform the search. 
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Adding Search Criteria 

If you need to search for more than just one item or keyword, you can do that by entering one or more 
criteria to the search. 

To add a criterion to your search: 

1. Click the drop-down arrow  to open an extra pane. 

 

2. In the Name field, enter the name of the item you want to search for.  

If you want to change the field that you search in, click the name of the field and a list appears 
displaying the names of all the fields in the current item.  

 

3. To add an extra criterion, enter a name in the Add Criteria field and then click Add Criteria. 
Click the name of the criterion to change it to one of the pre-defined criteria.  

 

4. Now enter the value for the new criterion and press ENTER. The items found below the selected 
item in the content tree are displayed first.  
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5. Click a search result to open it in the editing pane. 

Removing a criterion 

To remove a criterion again, click the name of the criterion and then click Remove at the very bottom of 
the menu that appears. 

4.1.4 Locking in the Content Editor 

In the Content Editor, you must lock an item before you can edit it. And once you are done editing the 
item you must unlock it again to make it available for other content authors to work on. 

Locking an Item 

To lock an item: 

1. In the Content Editor, navigate to the item that you want to edit. 

2. On the Home tab, click Edit to lock the item. 

 

When you lock the item, the functions and commands that are available to you are activated in 
the Content pane. 

 

To get a quick overview of your locked items you can activate the quick action My Locked Items 
in the quick actions bar left of the content tree. Right-click left of the content tree and select My 
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Locked Items in the floating menu. 

 

Unlocking an Item 

When you have finished editing the item, you must remember not only to save the changes but also to 
unlock the item so that other users can edit it. 

To unlock the current item, either click Edit on the Home tab or click Check In in the Workflow group on 
the Review tab. 

 

Unlocking Multiple Items 

As a content author, you often have to make extensive changes to many items on the website. This can 
mean that you have to lock many items and keep them locked to ensure that your changes are 
implemented consistently across all the items. 

Sitecore keeps track of all the items that are locked to ensure that nobody else can edit them. It also 
keeps track of all the items that have been locked by each individual user.  

To unlock the items you have locked: 

1. In the Content Editor, click the Review tab. 
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2. In the Locks group, click My Items. 

 

The My Items dialog box lists all of the items you have locked. You may have locked these items 
during the current session or during previous sessions. 

3. Select the items that you are finished editing and click Unlock to unlock them, or click Unlock All 
to unlock all the items. 
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4.2 Editing an Item in the Content Editor 

Experienced content authors might feel more at home with the advanced functionality that is available in 
the Sitecore Content Editor. 

In the Content Editor, you can edit all of the fields that an item contains — rich text fields, Word fields, 
image fields, and so on.  

In all the procedures and tasks described in this chapter, it is assumed that you have already locked the 
item.  

4.2.1 Editing a Rich Text Field in the Content Editor 

After you have selected an item in the content tree, you can edit it. 

To edit a Rich Text field in the Content Editor: 

1. In the Content Editor, locate the item that you want to edit in the content tree. 

 

2. In the Content pane, locate the field that you want to edit. 

3. Click Show Editor to open the Rich Text Editor. 
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The Rich Text Editor gives you access to more functionality than inline editing. You can: 

o Insert and delete links to other parts of the website and to external websites. 

o Insert pictures or other media items. 

o Insert symbols into the text 

o Paste text from Microsoft Word into the item.  

If you prefer, you can use Microsoft Word to write the text that you want to use in the item and 
paste it into the Rich Text Editor. 

o Find and replace text in the item. 

Note 
The functionality that is available in the Rich Text Editor is controlled by your Sitecore system 
administrator. If you need more functionality, ask your administrator to make it available to you. 

Furthermore, you can also view the item in HTML format, if you have the necessary expertise and 
feel comfortable editing the text in that format.  

4. When you are finished editing the item in the Rich Text Editor, click Accept to save the changes 
that you have made to the field. 

5. To check the spelling, click the Review tab and, in the Proofing group, click Spelling to start the 
spell checker. The spell checker runs through all the text fields in the item. 

6. When you have finished editing the item, click Save to save the changes you have made to the 
item and then click Edit to unlock the item so that other users can edit it if they need to. 

Note 
The spell checker only checks the current item. If you have edited several items, you must open them 
individually and run the spell checker. 

For more information about using the Rich Text Editor, see the section The Rich Text Editor. 

4.2.2 Editing a Word Field in the Content Editor 

You can also edit Word fields in the Content Editor. 

Important 
You must have Microsoft Word 2007 or later installed on your computer to edit Word fields in Sitecore. 

Sitecore Word fields are only supported on Internet Explorer 7 or later. 

If you are using Internet Explorer 8, the first time you access a Word field in Sitecore, you will receive an 
error telling you that your security settings will not let you run ActiveX controls on the page. 

For more information about how to configure Internet Explorer 8 to run this ActiveX control, see the 
section, Configuring Word Fields. 
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To edit a Word field: 

1. In the Content Editor, open the item that you want to edit. 

 

2. Click Edit to open a new window displaying the content of this field in Word. 

 

This window gives you access to all of the functionality in Word. 

3. To insert a Sitecore link to another item on your website, click Insert Link. 

4. To insert an image from the Media Library, click Insert Media. 

5. To insert an image that is not in the Media Library, use the functionality in Word. 

You should upload any images that you want to use regularly to the Media Library. 

6. When you are finished editing the Word field, click Accept to save your changes and close the 
window.  
To close the window without saving your changes, click Reject. 

7. In the Content Editor, save your changes and unlock the item. 

For more information about Word, see Microsoft’s documentation. 
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4.2.3 Working with Graphics 

As a content editor, you may often have to change or edit the media items that are displayed on your 
website.  

Changing an Image in the Image Field 

To change an image in the Image field: 

1. In the Content Editor, locate the item that you want to edit in the content tree. 

 

2. In the Content pane, click Browse to open the Select Media dialog box. The Select Media 
dialog box opens and displays all the items from the Media Library that is available for the image 
field you have chosen. 
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Note 
The items are not listed in any particular order in the Select Media dialog box, so use the search 
functionality or the pre-defined lists from the menu to find a particular item. 

3. In the Media menu you can use the links to quickly get a complete list of: 

o All image files 

o All video files 

o My images – this lists all the image files that have been updated by the current user. 

o Recently uploaded images 

o Recently uploaded videos 

4. To filter the displayed media items according to specific metadata of the image, click the Filter 
drop-down button and select the required filters. The number in parenthesis indicates how many 
items are available for the filter. 

 

5. If you want to search for a specific item, enter a search word in the Search field. 

6. If you want to navigate through the content tree to find the image that you want to use, click the 

Tree View button  in the upper right corner of the Select Media dialog box. This displays the 

Media Library in a content tree. To go back to list view click the List view button  

 

7. Select the image that you want to use, click Select Media, and the new image is inserted into the 
image field. 
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Uploading an Image 

If the image you want to use is not available in the Media Library, you can easily make it available by 
uploading it to the Media Library. 

To add an image to the Media Library: 

1. In the Content pane, click Browse to open the Select Media dialog box. 

2. Click  Upload media to upload a new media item to the library. 

 

3. To add the new media items to the Upload Media dialog box, you can: 

o Click Browse for media files to navigate to the image that you want to add to the Media 
Library.  

o Drag and drop the images directly into the Upload Media dialog box.  

4. Add as many media items to the Upload Media dialog box as you need and be sure to enter the 
appropriate name, description, and alternate text for each new media item. 

5. When all the necessary media items have been added, click Upload media. 

6. When the upload is completed, click Back to go back to the Select Media dialog box.  

The image is now uploaded to the Media Library and you can use it on your website. 

Editing the Properties of an Image 

After you have added an image to an item in the Content Editor, you can edit the properties of the image. 



Sitecore CMS 7.1 Content Author's Reference and Cookbook  

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of 
this document are the property of Sitecore. Copyright © 2001-2013 Sitecore. All rights reserved.  

Page 56 of 188 

To edit the properties of the image: 

1. In the Content pane, scroll to the field containing the image. 

 

2. Click Properties to open the Image Properties dialog box.  

 

3. In the Alternate Text field, enter the text that you want to appear in the tooltip for this image 

4. In the Dimensions section, specify the dimensions that the image should be displayed in — if 
they differ from the actual size of the image. 

5. In the Space section, specify how much space should be placed around the image. 

Editing an Image 

You can use Sitecore to edit the image if you need to.  
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To edit an image: 

1.  Scroll to the field that contains the image. 

 

2. Click Edit Image to open the image. If you use Windows XP, Sitecore opens the built-in Image 
Editor. In the built-in Image Editor, you can crop, resize, flip, and rotate the image. 

 

If you use Windows 7 or Windows Vista, Sitecore opens the image using the default image editor 
on your computer. You edit and save the image and then close the editor. 

3. When you are finished editing the image, click Save and close the Image Editor to return to the 
Content Editor. 

All the changes that you make are applied to the version of the image that is stored in the Media 
Library and not just the copy shown on your web page. 

4. In the Content Editor, click Refresh to see the changes that you made. 

5. If you want to remove the image, click Clear. 
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4.3 Creating New Items in the Content Editor 

There are several ways to create new items in the Content Editor. 

You can: 

 Create a new item 

 Duplicate an existing item 

 Copy an item to another location.  

 Create an item based on a template. 

In the Content Editor, when you insert a new item, it is generally created as a sub item of the current item. 
However, you can also create a new item at the same level as the current item. You cannot create an 
item that is at a higher level than the current item. 

The following sections describe how to use the Sitecore ribbon to create, copy, move, duplicate, and 
delete items. You can also access all of this functionality by right-clicking in the content tree. 

 

4.3.1 Creating a New Item 

You can easily create a new item as a subitem of the current item. 

Inserting a Subitem 

To insert a new subitem: 

1. In the Content Editor, locate the item for which you want to create a new subitem. 
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2. In the Insert group, click one of the item types that is displayed, enter the name of the new item, 
and click OK. 

 

3. If the item type you want to insert is not displayed, click the scroll arrows in the Insert group to 
find the type of item you want. 

Alternatively, in the Insert group, click the drop-down arrow  and select the subitem from the 
list that appears. 

 

4. In this drop down list, you can select a subitem or a sibling. A sibling is an item on the same level 
as the current item. 

To insert an item at the same level as the current item, in the Insert a New Sibling section, click 
Site Section. 

In this example, we add a new product category to the list. This new category is a subitem of an 
item and can contain its own subitems. 

5. Select the type of subitem that you want to create and a dialog box appears prompting you to 
name the new item. 
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6. Enter a name for the new item. 

The new item is now added to your website.  

 

As you can see, the new item has been created as a subitem and has been automatically locked. 

Every new item that you create is automatically locked and opened for you. You must unlock 
them before other users are allowed to edit them. 

7. Edit the new item. Scroll down through the fields and add an image, text, and so on. 

When you have finished editing the item, you can add a new subitem to it. 

4.3.2 Duplicating an Existing Item 

Sitecore lets you duplicate existing items. 

To duplicate an existing item: 

1. In the content tree, locate the item that you want to duplicate. 

2. On the Home tab, in the Operations group, click Duplicate and a dialog box appears prompting 
you to name the new item. 

3. Enter a name for the new item and it is added to the content tree. 
The duplicated item is added at the same level as the original item. It also contains all of the 
same text, images, and so on as the original item. 

4. Edit the new item and enter the text, images, and so on that you want to be displayed in this item. 
When you have finished editing the item, you can move it to another location if necessary. 

Moving an Item 

To move an item: 

1. In the content tree, locate the item that you want to move. 
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2. On the Home tab, in the Operations group, click Move To. 

 

3. In the Move Item To dialog box, select the location that you want to move the item to. You can 
navigate to the location in the content tree on the Browse tab or search for the location on the 
Search tab. 

4. Click Move to move the item to the new location. 

For more information about the Sitecore search functionality, see the section Searching in Sitecore. 

4.3.3 Copying an Item to another Location 

You can also create a new item by copying an existing item to the location where you want the new item 
to belong. 

To copy an item to another location: 

1. In the content tree, locate the item that you want to copy. 



Sitecore CMS 7.1 Content Author's Reference and Cookbook  

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of 
this document are the property of Sitecore. Copyright © 2001-2013 Sitecore. All rights reserved.  

Page 62 of 188 

2. On the Home tab, in the Operations group, click Copy To. 

 

3. In the Copy Item To dialog box, select the location that you want to copy the item to. You can 
navigate to the location in the content tree on the Browse tab or search for the location on the 
Search tab. 

4. Click Copy and the item is copied to the specified location.  

5. To rename the new item click Rename on the Home tab, in the Rename group. 

 

6. Enter the new name of the item and click OK. 

For more information about the Sitecore search functionality, see the section Searching in Sitecore. 

Copying Multiple Items to another Location 

If you want to copy multiple items to a specific place at the same time, you can use the search operations 
in the Sitecore search engine.  

For more information on how to use the search operations, see section Searching in Sitecore. 

4.3.4 Creating an Item Based on a Template 

If you have been given sufficient access rights, you can also create an item based on a template. You can 
create a new item based on any template. 

To create an item based on a template: 

1. In the content tree, locate the item that you want to create a subitem for. 
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2. On the Home tab, in the Insert group click the scroll arrow  and select Insert from Template. 

The Insert From Template dialog box opens. The Search tab already contains a list of all the 
available templates. 

 

You can either search for the template you want to base the item on, or click the Browse tab and 
navigate to the item in the content tree.  

For more information on how to optimize your search, see the section Searching in Sitecore. 

3. In the Insert from Template dialog box, select the template that you want to use to create the 
new item. 

4. In the Item Name field, enter a name for the new item. 

5. Click Insert, and the item is added to the content tree. 

6. Now edit the item and save your changes. 

Previewing Your Changes 

When you have finished editing all the new items that you have created you might like to see how these 
new items will look on your website.  

To see a preview of your changes: 

1. Click the Publish tab. 

2. In the Publish group, click Preview to see how the item looks. 

A new browser window opens displaying the current item. You can then browse the website to see all the 
changes that have been made. 

When you are satisfied with all the changes that you have made, unlock all the items that were locked to 
make them available to other users. 
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4.4 Deleting Items in the Content Editor 

Content authors must inevitably delete content items from time to time. When you delete a content item, 
you can delete the entire item including every version of the item and all of its subitems or just some 
individual versions of the item. 

4.4.1 Deleting an Item 

To delete an item from the website: 

1. In the content tree, locate the item that you want to delete. 

2. On the Home tab, in the Operations group, click Delete. 

Alternatively, you can right-click the item in the content tree and click Delete in the shortcut menu 
that appears. 

The entire item is deleted from the website — every version of the item in every language is 
deleted. 

If you try to delete an item that contains subitems, a message appears informing you that the 
section contains subitems and that these items will be deleted along with the main item. 

 

If you want to save any of the subitems, click Cancel and then move the subitems to another part 
of the website before you delete the parent item. 

3. Click OK to delete the item and its subitems. 

4.4.2 Deleting a Version of an Item 

If you have created several different version of the same item, you can delete individual versions of the 
item without deleting the entire item or any of its subitems.  
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To delete a version of an item: 

1. In the content tree, locate the item that has a version that you want to delete. 

 

2. In the right-hand pane, on the Content tab, click the language button  and select the language 
version that you want to delete.  

3. Click the Versions button  and select the version in this language that you want to delete. 

4. On the Versions tab, in the Versions group, click Remove and this version is deleted from the 
website and placed in the Recycle Bin. 

4.4.3 Deleting Multiple Items 

If you want to delete multiple items from Sitecore, it is recommended that you use the Sitecore search 
interface. On the Search tab, you can search for the items that you would like to delete.  

To search for and delete multiple items: 

1. In the Search field, enter your search keyword. 

Use the necessary facets or filters to narrow down your search to list only the items that you want 
to delete.  
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2. On the left of the search field, click the drop down button. 

 

3. Click Search Operations and then click Delete Results. 

Warning 
Once you click Delete Results, the result items are deleted without warning or confirmation. 

For more information about using the Sitecore search functionality and the search operations, see the 
section Searching in Sitecore. 

4.4.4 Removing Items from the Recycle Bin 

When you delete a content item from the content tree, it is moved to the Sitecore Recycle Bin. In the 
Recycle Bin, you can permanently delete individual items or empty the bin completely. 

To delete an item permanently, open the Recycle Bin, and in the Operations group, click Empty. 

To delete individual content items, open the Recycle Bin, select the item that you want to delete and in 
the Operations group, click Delete. 

4.4.5 Restoring a Version of an Item 

After you have deleted an item, you can also restore the entire item or some individual versions of the 
item. 
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To restore a version of an item: 

1. In the Content Editor, click the Sitecore start button in the lower left corner and then click 
Recycle Bin. 

 

2. In the Recycle Bin, in the Options group, select the Show Versions check box and the Recycle 
Bin lists all the deleted versions of the current item.  

 

3. Select the version of the item that you want to restore and then in the Items group, click Restore 
and the item is restored in the content tree. 
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4.5 Archiving 

Sitecore also allows you to archive content that you do not want to display on your website. When you 
archive an item, it is not deleted but instead, it is stored outside the content tree and can be restored at 
any time. 

The Sitecore archive functionality allows you to: 

 Archive an entire content item — including its sub items. 

 Archive individual versions of a content item. 

 Specify a date and time when a content item or individual versions of a content item should be 
archived automatically. 

 Restore content items from the Archive. 

 Restore individual versions of content items from the Archive.  

When you archive a content item, it is removed from the content tree, but it remains on the published 
website. Therefore you must republish the website to ensure that these changes are replicated on the 
website.  

4.5.1 Archiving and Restoring a Content Item 

In Sitecore, you can archive a content item and then restore it again when you need it.  

To archive a content item: 

1. In the content tree, navigate to the item that you want to archive. 

 

2. On the Review tab, in the Schedule group, click Archive and then click Archive Item Now. 

The content item is moved to the Archive. 
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To restore a content item from the Archive: 

1. In the Sitecore Desktop, click the Sitecore start button and then click All Applications, Archive. 

 

2. In the Archive, select the content item that you want to restore. 

3. In the Items group, click Restore and the content item is restored in the content tree. 

You can only restore one item at a time. 

4.5.2 Archiving and Restoring a Version of a Content Item 

In Sitecore, you can archive and restore individual versions of content items. 

To archive a version of a content item: 

1. In the content tree, navigate to the item that you want to archive. 

2. In the right hand pane, on the Content tab, click the Language button  if you want to archive 
a version in a particular language. 
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3. Click the Version button  and select the version that you want to archive. 

 

4. On the Review tab, in the Schedule group, click Archive and then click Archive Version Now 
and this version of the current item is moved to the Archive. 

To restore a version from the Archive: 

1. In the Sitecore Desktop, click the Sitecore start button and then click All Applications, Archive. 

2. In the Archive, in the Options group, select the Show Versions check box. 

3. Select the content item that contains the version that you want to restore and all the archived 
versions of this content item are displayed in the lower pane. 

 

4. Select the version that you want to restore and in the Items group, click Restore and this version 
of the content item is restored in the content tree. 

You can select and restore as many versions of the same item as you want. However, you can 
only select one item and restore versions of that one item at a time. 
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4.5.3 Automatically Archiving a Content Item 

You can also specify a date and time for when a content item should be archived automatically. 

To specify when a content item should be archived: 

1. Open the Content Editor, and in the Content Tree, locate the item that you want to archive. 

2. On the Review tab, in the Schedule group, click Archive and then click Set Archive Date. 

 

3. In the Archive Date and Time dialog box, in the Archive Item section, you specify the date and 
time when you want to archive the entire item. 

4. In the Archive Version section, you specify when you want to archive individual versions of the 
current item. 

The content item or the versions you select are archived on the date and time that you specify. 

When you set a date and time, it is important to remember that: 

o If you only specify a date, the item is archived at 12:00 midnight on that date. 

o If you only specify a time, the item is archived at that time on the current date. 

o If you specify a date or a time that is in the past, the item is archived the next time that 
Sitecore checks if there are any items that should be archived. 
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4.6 Cloning Items 

Sitecore lets you create clones of items and branches of items. Clones are not just copies of the original 
item. The fields in clone items are updated when the corresponding fields in the original item are updated.  

Cloning items is as a way of centralizing content items. It is a very useful way to place your items 
throughout the content tree, and then have the content controlled from one central location in the content 
tree. For example, when you have multiple sites in Sitecore – each for a different country, you can create 
a master site that contains the common content items for all the sites. Then for every country site, you 
create a clone of the master site, which means that when you update an item in the master site it is then 
automatically updated in all the country sites as well. 

This section describes how to use the item cloning functionality. In this document, the item that is being 
cloned is called the original item. 

4.6.1 Creating a Clone of an Item 

This section describes how to create a clone of an item. 

To create a clone of an item: 

1. In the content tree, select the item that you want to clone. 

2. On the Configure tab, in the Clones group, click Clone. 

 

3. In the Clone Item dialog box, select the location where you want to store the clone. You can 
navigate to the location in the content tree on the Browse tab or search for the location on the 
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Search tab. 

 

4. Click Clone. 

5. Sitecore creates a clone item that is exactly the same as the original item.  

If you select the clone item, you notice that the field titles have the [original value] text added. 
This means that these values match the corresponding values in the original item. 

 

If you select the original item and edit the Title field, Sitecore changes the same field in the clone item 
accordingly. You can create multiple clones of the same item. 

For more information about the Sitecore search functionality, see the section Searching in Sitecore. 

Cloning multiple items 

With the Sitecore search functionality, you are able to clone multiple items at the same time and place the 
clones in a specific location in the content tree. This can be done using the search operations in Sitecore 
search.  

To clone multiple items using the search operations: 

1. Click an item in the content tree from where you want to search for the items you want to clone. 

2. In the editing pane click the Search tab. 
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3. In the Search field, enter your search keyword and press ENTER. Use the necessary facets or 
filters to narrow down your search to list only the items you want to clone.  

4. Click the drop-down arrow to the left of the search field. 

5. Click Search Operations and then click Clone Results To. 

 

6. The Clone Item dialog box opens, asking you to select the location in the content tree where you 
would like to clone all the search result items to.  

 

7. To select the location, on the Browse tab, navigate through the content tree or on the Search tab 
to search for it. 

For more information about using the Sitecore search functionality and how to clone multiple items, see 
the section Searching in Sitecore. 
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4.6.2 How Clones and Original Items Interact 

When you create a clone, Sitecore establishes a connection between the clone and the original item. 
When you edit the fields of the original item, Sitecore updates the corresponding fields in its clones. If you 
edit a field in a clone item, and then edit the same field in the original item, a conflict occurs and Sitecore 
asks you how you want to resolve this conflict.  

This section describes some common use cases that demonstrate how clones and original items interact. 

In these examples, we will work with an original item called Laptop and its clone. In this screenshot, the 
clone is selected. 

 

Now let’s see how cloning works. 

1. Edit a field in the original item and save it. 

 

Sitecore updates this field in all the clones of this item. 

 

Notice the [original value] text on the right side of the field title. 
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2. Edit a field in the clone and save it. The [original value] text disappears from the title. 

 

The original item has not changed. 

3. Edit the same field in the original item. 

 

4. Select the clone. In the Content tab, Sitecore displays a message telling you that a field in the 
original item has been changed and gives you a number of options. 

 

You can: 

o Review the original item 

Sitecore selects the original item and you can review the changes. 

o Accept the change 

Sitecore copies the values from the fields in the original item to the corresponding fields in the 
clone item. The [original value] text appears next to the field titles. 

o Reject the change 

Sitecore keeps the existing field value in the clone item and hides the message. 
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4.6.3 Cloning and Child Items 

If you create child items under the original item, Sitecore helps you decide whether or not you want to 
create clones of these subitems. 

To see how it works, let’s consider the following scenario: 

1. Select the original item and create a child item. 

 

2. Select the clone item.  

 

In the Content tab, Sitecore displays a message telling you that a new subitem has been created 
under the original item. 

The options are: 

o Review the new subitem 

If you click this option, Sitecore selects the new subitem and you can review it. 

o Create a clone of the new subitem 

If you click this option, Sitecore creates a clone of the new subitem. 

o Do not create a clone of the new subitem 

If you click this option, Sitecore does not create a clone of the new subitem and it hides the 
message. 

4.6.4 Cloning and Versioning 

When you create a clone of an item that has multiple versions, only the latest version is copied to the 
clone. For example, if you clone an item that has three versions, the clone will have one version 
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corresponding to version 3 of the original item. If you select the original item and edit version 2, the clone 
will not reflect those changes because it is connected to version 3. 

If you select the clone and add a new version, the new version is connected to the same version of the 
original item as the previous version of the clone. 

The following examples provide more details on how cloning works. 

Adding a New Version to the Original Item 

This section describes what happens when you add a new version to the original item. 

1. Add a new version to the original item. 

2. Select the clone item. Sitecore displays a message telling you that a new version of the original 
item has been created. 

 

The options are: 

o Review the new version 

If you click this option, Sitecore selects the original item.  

o Update to new version 

If you click this option, Sitecore copies the new version of the original item and adds it to the 
clone. 

o Do not update to the new version 

If you click this option, Sitecore does not copy the new version and hides the message. 

Removing a Version of the Original Item 

This section describes what happens if you remove the version of the original item that is connected to 
the clones. 

1. Select the original item. 

2. Select the version that is connected to clones. 

3. On the Versions tab, in the Versions group, click Remove.  
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Sitecore displays the message telling you that this version of the item has a clone. 

 

If you click OK, Sitecore removes this version from the original item and unclones all the clone 
versions that were connected to this version of the original item. 

Viewing Clones in the Search Results 

In the search results, a clone is represented with an indent and it is displayed at the end of the search 
results. Furthermore, the item has the Go To Item Source quick action assigned to it by default. This is a 
shortcut to the original item. 

 

4.6.5 Uncloning an Item 

If you no longer want to have a connection between the original item and the clone, you can unclone the 
clone item. 

To unclone a clone item: 

1. Select the clone. 
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2. On the Configure tab, in the Clones group, click Unclone. 

 

Sitecore leaves all the fields in the clone as they are and removes the connection between the 
clone and the original item. The clone becomes a normal item. 

4.6.6 Deleting an Original Item 

If you try to delete an item that has clones, Sitecore displays a message. 

 

In the message, Sitecore lists all the clones of the current item and the clones of its child items. If you 
click OK and delete the item, the clones keep their current field values and become normal items. 

When you delete an original item, all its clones are uncloned. 

4.6.7 Cloning and Workflows 

If you clone an item that is in a workflow, the workflow and the Workflow state properties are copied to the 
clone item. After the workflow fields are copied, the workflow properties of the clone and the workflow 
properties of the original items are not connected any more. If you change the workflow state of the 
original item, the workflow state of the clone is not changed. 
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4.6.8 The __Source Field 

Each version of a clone is connected to a version of the original item. This is defined in the Advanced 
section in the __Source field. 

 

To view this section, in the View tab, select the Standard Fields check box. 
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4.7 Setting Reminders 

In Sitecore, you can send e-mail notifications to multiple users at a specified point in time in the future. 
This feature is particularly useful if you have time sensitive content on your website. For example, if your 
website contains a special offer that runs out on a certain time and date, you can use the Sitecore 
reminder feature to send yourself or others a reminder to remove the offer from the website at the 
appropriate time. 

To set a reminder: 

1. In Sitecore Content Editor, on the Review tab, in the Schedule group, click Reminder. In the list 
of options that opens, select Set Reminder. 

 

The Set Reminder Wizard opens.  
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2. In the Set Reminder Wizard, on the Welcome to the Set Reminder Wizard page, click Next, 
and the Reminder Text dialog box opens.  

 

3. In the Reminder Text dialog box, in the Reminder text field, enter the text that you want to be 
sent to recipients as a reminder, and then click Next. The Date and Recipients dialog box 
opens.  

 

4. In the Date and Recipients dialog box, in the Date fields, enter the date and time when the 
reminder e-mail must be sent. In the Recipients field, enter e-mail addresses of the recipients, 
and then click Set.  

5. On the last page of the Set Reminder Wizard, click Finish and the reminder is configured.  

You can verify when the reminder that you created is going to be sent to recipients. To do this, on the 
Review tab, in the Schedule group, click Reminder. The reminder details are displayed above the Set 
Reminder option.  
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To clear the reminder you configured, on the Review tab, in the Schedule group, click Reminder, and 
then click Clear Reminder.  

Note 
Currently, you can only configure one reminder. If you already have one reminder, and want to set 
another reminder, you overwrite the earlier reminder.  
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Chapter 5  

The Rich Text Editor 

The Rich Text Editor is the word processing tool that Sitecore uses. This chapter explains 
some of the functionality that it contains. The topics described in this chapter include 
inserting, removing, and managing links. 

This chapter contains the following section: 

 Using the Rich Text Editor 
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5.1 Using the Rich Text Editor 

When you are editing a rich text field in the Page Editor or Content Editor, you use the Rich Text Editor. 
This is a standard word processing tool, but in Sitecore, we have removed most of the formatting 
functionality because the format of the items that content authors create and edit is determined by the 
style sheets and templates that have been implemented for your website. 

5.1.1 Editing Text 

To open the Rich Text Editor, place the cursor in a rich text field and Sitecore opens a floating menu, from 

where you click the Edit Text icon . The Rich Text Editor opens displaying the text from the field you 
clicked. 

 

You can now edit the text and use the functionality that is available.  

Pasting Content from Word 

As a content author, you might feel more comfortable writing your content in Microsoft Word. When you 
have written the text, you can paste it from Word and into the Rich Text Editor. Note that all the 
information about fonts, sizes, formatting, and so on, is removed once the text is pasted into the Rich Text 
Editor. 

To paste content from Microsoft Word: 

1. Select and copy all the text in Microsoft Word that you want to paste into a rich text field in 
Sitecore. 

2. In Sitecore, place your cursor in the rich text field item that you want to edit and click Edit Text  
to open the Rich Text Editor. 

3. Click the Paste Word button  and the text is pasted into the Rich Text Editor. 

5.1.2 Inserting an Internal Link 

An internal link is a link to another item on your website. 

To add an internal link: 

1. In the Rich Text Editor, select the image or text that you want to make into a link. 
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2. Click the Insert Sitecore Link button . 

 

3. In the Insert a Link dialog box, you can select the item that you want to create a link to: 

o By navigating the content tree on the Internal Link tab. 

o By navigating the content tree on the Media Items tab if the item is a media item. 

o By searching for the item on the Search tab. This can be useful if for example the item is a 
hidden item in an item bucket. For more information on item buckets, see the section Item 
Buckets. 

4. Click Link to create the link. 

5.1.3 Inserting an External Link 

An external link is a link to another website. 

To insert an external link: 

1. In the Rich Text Editor, select the image or text that you want to be a link. 

2. Click the Insert Link button . 
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3. In the Hyperlink Manager dialog box, enter the information about the website that you want to 
link to. 
 

Field Value 

URL Enter the URL of the website. 

Document Manager  
Opens the Document Manager dialog box from 
where you can choose the media item to link to. 

Link Text Enter or edit the link text. 

Target  Specify the window in which the link should open. 

Existing Anchor Select an existing anchor. For more information on 
anchors see the following sections  

Tooltip  Enter a tool tip that is displayed when you move the 
mouse over the link. 

CSS Class  Specify the style sheet that the link should use.  

5.1.4 Managing Hyperlinks 

You can also use the Hyperlink Manager dialog box to edit existing links, create anchors, and create e-
mail links.  

Creating an Anchor 

An anchor is an HTML code that is used to create a link to another page or to a particular section within a 
page. 

To create an anchor: 

1. In the Rich Text Editor, select the image or text that you want to be an anchor. 

2. Click the Insert Link button . 

3. In the Hyperlink Manager dialog box, click the Anchor tab. 

 

4. In the Name field, enter the name of the anchor. 
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5. You can now create a link to this anchor by selecting it in the Hyperlink Manager dialog box. 

 

Creating e-mail links 

You can also use the Hyperlink Manager to create e-mail links. An e-mail link opens a new mail in the 
program that you use to send e-mail, for example, Microsoft Outlook. The e-mail will be sent to the e-mail 
address specified in the e-mail link. 

To create an e-mail link: 

1. In the Rich Text Editor, select the image or text that you want to be the link. 

2. Click the Insert Link button . 

3. In the Hyperlink Manager dialog box, click the E-mail tab. 

 

4. In the Address field, enter the e-mail address that the mail should be sent to. 

5. In the Subject field, enter the text that you want to appear in the subject field in the e-mail. 

5.1.5 Removing a Link 

To remove a link, in the Rich Text Editor, select the link and click the Unlink button . The link is 
removed and the text becomes ordinary text. 

Note 
You can use the Hyperlink Manager to edit any links that exist on your website. 
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Chapter 6  

Item Buckets 

In the Sitecore Content Editor, you can see that all of your content items are stored in the 
content tree. As your website grows and you create more items, the size of the content 
tree grows. If you have a website that markets or sells innumerable products or uses an 
ever increasing number of media files, the content tree will grow continually. As the 
content tree grows, it gets more difficult to locate individual content items and 
performance can decrease. 

Item buckets is a system that lets you store an unlimited amount of content items in one 
container that you can then search in to find specific content items. Item buckets is 
primarily targeted at storing content that does not need to be stored in a hierarchy. 

This chapter contains the following sections: 

 Fundamental Concepts 

 Working with Item Buckets 
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6.1 Fundamental Concepts 

This section explains some of the basic concepts used in item buckets. 

6.1.1 Item Bucket 

An item bucket is a repository in the content tree that can store other content items. The difference 
between an item bucket and a regular container in the content tree is that an item bucket can store a 
theoretically unlimited amount of items without displaying them in the content tree.  

The items in an item bucket are hidden in the content tree by default, which is why you cannot use the 
content tree to navigate and select these items. Instead, you can search for and open items that are 
stored in an item bucket via the Sitecore search engine. 

The parent to child relationship between the content items in an item bucket is completely removed and 
the items are automatically organized in a folder structure. By default, the items are organized according 
to the date and time when they were created. However, you can configure your Sitecore solution to 
organize the bucketed items differently, for example by their globally unique identifier (GUID). 

To get an overview of the containers that are item buckets in the Content Editor, you can right-click the 
Quick Action Bar to the left of the content tree and select Item Buckets. An icon is now displayed beside 
each item bucket in the content tree. Additionally, if you expand an item bucket in the content tree you will 
also see a visible cue, that the container is an item bucket. If the items in an item bucket are hidden, a 
small notification tells you that there are hidden items in the container.  

 

When you need to work with a specific item placed in an item bucket, you need to search for it and open it 
from the list of search results. The advanced Sitecore search functionality allows you to search among all 
items in Sitecore using, for example, free text, search filters, or facets that makes it easier for you to find 
exactly what you need.  

For more information about using the search functionality, see the section Searching in Sitecore. 

Why Use a Bucket? 

An item bucket addresses the problem of managing large numbers of items within the content tree, 
retrieving them, and working with them in a speedy and efficient manner.  

Using item bucket has many advantages, including: 

 All the content items are automatically organized in an item bucket in a logical format, so that the 
performance of the search engine increases. 
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 A single item bucket can contain millions of content items without slowing down the UI or 
congesting the content tree. 

 You can have as many buckets as you want. This is useful if you want to split up your buckets 
into logical containers for example one for products and one for articles. 

To decide if you should turn an item into an item bucket, and in-turn, hide all its descendants, you must 
ask yourself if you care about the structure of the data that is stored in the item bucket.  

For example, if you have items within the content tree that contains a large number of sub items such as 
products, media, or tags, it may be an advantage to turn these items into item buckets and thereby 
remove the need for hierarchically managing the content. Note that a connection between two or more 
items does not necessarily need to be hierarchically. 

6.1.2 Items in an Item Bucket 

An item bucket can contain both normal content items and bucketable content items. 

 Normal content items stored in item buckets are visible in the content tree and maintain their 
parent child relationship. A normal content item is based on a template that doesn’t support item 
buckets.  

 Bucketable items are hidden in the content tree and do not maintain their parent child 
relationship. A bucketable item is based on a template that supports item buckets. 

Note 
In an item bucket, we do not recommend using both non-bucketable and bucketable items. This can 
introduce unnecessary complexities for the developers. 

Viewing Hidden Items 

If you need to view the bucketable items that are hidden in the item bucket, in the Content Editor, on the 
View tab, in the View group, select the Buckets check box. 

However, we recommend that you clear the Buckets check box when working with item buckets. This will 
prevent the system from unnecessarily loading all the items in the content tree and slowing down 
performance. Remember that you can still work with the hidden content items by searching for them on 
the Search tab that is available for every item bucket. 

6.1.3 Searching in Item Buckets 

Once you start using item buckets, you will soon have buckets that contain hundreds if not thousands of 
hidden content items. This underlines the need for a search functionality that can help you to find specific 
content items that you need to edit. To this end, Sitecore has implemented a new search interface.  
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When you convert a content item into an item bucket, the item opens on the Search tab in the editing 
pane.  

 

On the Search tab you can search through all the items in an item bucket, whether they are hidden items 
or normal content items. Sitecore offers a wide range of search filters, search operations, and facets that 
can help you to quickly find the content item you are looking for.  

For more information about the search functionality, see the section Searching in Sitecore. 



Sitecore CMS 7.1 Content Author's Reference and Cookbook  

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of 
this document are the property of Sitecore. Copyright © 2001-2013 Sitecore. All rights reserved.  

Page 95 of 188 

6.2 Working with Item Buckets 

This section describes how to work with item buckets. You can create an item bucket from any item, 
whether it is a new content item or an existing content item that you convert into an item bucket. 

Content items that are stored in item buckets are just like any other content items — you can create, edit, 
and delete them. 

When you convert a content item that already exists into an item bucket, the item bucket organizes and 
hides all its descendants if they are based on templates that are bucketable or if the item itself is set as 
bucketable. Depending on how many items it contains, it can take a considerable amount of time to 
organize the items after converting the item into an item bucket. A progress bar appears displaying a 
running tally of the items being processed. During the bucketing process it is possible to cancel the 
construction of the item bucket, in case you regret before the organizing of the items are complete. 

Note  
On a standard desktop PC we estimate that organizing 1000 items into an item bucket takes 
approximately 5-10 minutes. 

6.2.1 Creating an Item Bucket 

You can create an item bucket from a new content item or convert an existing item into an item bucket. 

To create an item bucket: 

1. In the Content Editor, in the content tree, create a content item, for example a folder, and give it 
a suitable name. 

Alternatively, select an existing content item. 

2. In the content tree, select the content item and then on the Home tab, click Edit to lock the item. 

3. Click the Configure tab and then in the Buckets group, click Bucket to convert the item into an 
item bucket. 
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When you convert a content item into an item bucket, a new Search tab appears in the editing pane. 

 

You use this tab to search for the content items that are otherwise hidden in the item bucket.  

For more information about the Sitecore search functionality, see the section Searching in Sitecore. 

Enabling the Item bucket Icon in the Quick Actions Bar 

In the Quick Action Bar, you can enable an item buckets icon, to indicate which content items in the 
content tree are item buckets.  

To display the item buckets icon, right-click the quick action bar left of the content tree, and select Item 
Buckets. 

6.2.2 Making a Template Bucketable 

If you have a large number of similar content items that you want to hide in an item bucket, we 
recommend making the template, that they are based on, bucketable. 

To make a template bucketable: 

1. In the Content Editor, on the View tab, in the View group, select the Standard Fields check 
box. 

2. Select one of the content items that you want to make bucketable. 

3. In the editing pane, on the Content tab, expand the Quick Info section. 

4. Click the template link and the template that this content item is based on opens in the Template 
Manager. 

5. In the Template Manager, in the content tree, expand the template in question and select the 
_Standard Values item. 

6. In the editing pane, click the Content tab. 
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7. Scroll down and expand the Item Buckets section. 

 

8. Select the Bucketable check box. 

9. Save your changes. 

After you have made the template bucketable, you must synchronize every item bucket that 
contains content items that are based on this template. This updates their structure and hides the 
bucketable items in the content tree. 

10. In the Content Editor, select an item bucket that contains items based on this template. 

11. On the Configure tab, in the Buckets group, click Sync. 

If you create any content items based on this template in another folder that is not an item bucket, these 
items are treated like normal content items and are displayed in the content tree. 

Changing a Bucketable Template to a Non-Bucketable Template 

If you want to make a template non-bucketable again, you can clear the Bucketable check box. This 
however, does not make the items based on that template visible in the item bucket only by synchronizing 
the item bucket. To make the items that are based on the non-bucketable template visible again in the 
item bucket, you need to also revert the item bucket to a normal container and then make it bucketable 
again. 

For more information about reverting an item bucket, see the section Reverting an Item Bucket to a 
Normal Container. 

6.2.2. Synchronizing an Item Bucket 

Whenever you make changes to the items in an item bucket you need to synchronize the item bucket to 
make sure all the items are organized correctly. 

You should synchronize an item bucket when: 

 Making the items in the item bucket bucketable. 

 Making the items in the item bucket unbucketable. 

 Updating the item bucket’s template to be bucketable. 

 Deleting an item from the item bucket. 
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 If the process of making an item bucketable fails during processing you can synchronize the item 
bucket after the process failed, and it will pick up from where it left off. 

To synchronize an item bucket: 

1. In the content tree, select the item bucket whose structure you want to update. 

2. On the Configure tab, in the Buckets group, click Sync. 

The structure of the contents in the item bucket is now updated: 

o The bucketable items are organized and hidden.  

o All the content items that are based on bucketable templates are organized and hidden.  

o The normal content items remain visible. 

You can use the Sitecore search engine to search for all the content items in the item bucket. For more 
information about searching in Sitecore, see the section Searching in Sitecore. 

6.2.3 Creating a Content Item in an Item Bucket 

You create a content item in an item bucket in exactly the same way as you would create an ordinary 
structured content item. 

To create a content item in an item bucket: 

1. In the Content Editor, in the content tree, select the item bucket that you want to create an item 
in. 

2. On the Home tab, in the Insert group, click the type of item that you want to create.  

3. In the dialog box that opens, enter the name of new you want to create. Click OK and the content 
item is created in the item bucket and available in the search results of the item bucket. 

4. The content pane of the new item opens from where you can further edit the item. As an example 
you can add tags to the new item, which is a great way to categorize your items and a quick way 
to search for the potentially millions of items in an item bucket. 

5. Save your changes. 

If the template that the item is based on is bucketable or if the item itself is bucketable, the item is hidden 
in the item bucket and you cannot see it. If the item or the item’s template is not bucketable, the item is 
visible in the item bucket. 

Consequently, you can have an item bucket that is a hybrid of structured and unstructured content items. 

For more information about making a content item bucketable, see the section Making a Template 
Bucketable. 

Tagging items 

Tagging items is a great way to categorize the potentially millions of items in an item bucket. If you tag 
your items, you get a quick way to search for specific categories of items in an item bucket.  

The tags that are available to you are defined by your administrator, and you can add them in the tagging 
section on the Content tab of the item.  
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To add a tag to an item: 

1. On the Content pane of the item, find and expand the Tagging section. 

 

2. In the left field you can either search for a specific tag in the search field or manually select the 
tag that you want to add to the item. You can use SHIFT or CTRL to select multiple tags. 

3. When you have selected the necessary tags, click the arrow to move the selected tags to the 
Selected field to the right.  

Use the arrow  if you need to remove selected tags from the selected field or double-click a 
single tag to move it from one field to the other.  

4. Click Save. Now you can insert and benefit from the search filter Search by Tag when searching 
for items in an item bucket. For more information on using search filters, see section Search 
Filters. 

6.2.4 Deleting a Content Item from an Item Bucket 

As you work with your website, you may need to delete a content item from an item bucket. 

To delete a content item from an item bucket: 

1. In the Content Editor, in the content tree, select the item bucket that contains the item that you 
want to delete. 

2. On the Search tab, in the search field, enter a search key word that will help identify the content 
item you want to delete. 
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3. In the search results, click the content item that you want to delete and it is displayed in a new 
tab. 

 

4. On the tab that displays the content item, on the Home tab, in the Operations group, click Delete 
and the item is deleted.  

5. Sync the item bucket. 

6.2.5 Restoring a Deleted Item to an Item Bucket 

If you regret deleting an item from an item bucket, you can restore the item from the Sitecore Recycle Bin. 
Remember to also rebuild the search indexes to ensure that the restored items appear in the search 
results. 

To restore a deleted item: 

1. In the Sitecore Desktop, click Sitecore, Recycle Bin. 

 

2. In the Recycle Bin, select the content item that you want to restore. 

3. Click Restore, and the item is restored in the content tree in the item bucket from where you 
deleted it. 
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To rebuild search indexes: 

1. In the Sitecore Desktop, click Sitecore, Control Panel. 

2. In the Control Panel, click Indexing, Indexing Manager and the Rebuild Search Index Wizard 
opens.  

This wizard guides you through the process of rebuilding the search indexes. There are three 
search indexes – one for each database in Sitecore: 

o sitecore_core_index 

o sitecore_master_index 

o sitecore_web_index 

3. When the wizard is finished, you can see the restored item in the search results for the 
appropriate item bucket. 

Note 
We recommend rebuilding indexes when you have made significant changes in Sitecore, such as adding 
or deleting thousands or millions of items. The purpose of rebuilding indexes for searching is to optimize 
the performance of the search.  

For more information about rebuilding the search indexes, see the manual Sitecore Search and Indexing. 

6.2.6 Deleting an Item Bucket 

If you delete an item bucket, all the items in the bucket, whether they are hidden or visible, are deleted as 
well.  

When you delete items in Sitecore, you need to decide what to do with the links that will break when you 
the delete the content item.  

You can choose to: 

 Remove the links that will break 

 Link to another item  

 Leave the links and manage them via the broken links report  
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6.2.7 Restoring a Bucket and the Content Items  

You can restore a deleted item bucket and the content items that it contains to the original location in the 
content tree. This can be done from the Sitecore Recycle Bin. Only by restoring the item bucket can you 
restore its sub items.  

To restore an item bucket: 

1. In the Sitecore Desktop, click the Sitecore start button and then click Recycle Bin.. 

2. Select the item bucket from the list of deleted items and click Restore. 

 

3. To view the restored item bucket in the content tree refresh the node in which the bucket is 
located. 

4. Rebuild the search indexes from the control panel, to make the restored items available for 
search again. 

For more information about rebuilding indexes, see the section Restoring a Deleted Item to an 
Item Bucket. 

6.2.8 Showing and Hiding Bucketable Items 

By default, every content item that is based on a bucketable template is hidden in the content tree. 
However, you can make these content items visible if you need to see them.   

To view bucketable items in the content tree: 

1. In the Content Editor, click the View tab. 

2. In the View group, select the Buckets check box.  
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Now, when you expand an item bucket, all of the items that it contains are displayed in the 
content tree in a folder structure based on the date and time for when the item was created.  

3. To hide the items again, clear the Buckets check box. 

Note 
We recommend that you hide the content items that are stored in the item buckets. This improves 
performance and ensures that your content tree is more manageable. 

6.2.9 Reverting an Item Bucket to a Normal Container 

After you have implemented an item bucket and stored some bucketable items in it, you may decide that 
this is not the correct structure for these items and turn the item bucket back into a normal content item. 

To revert an item bucket to a normal container: 

1. In the Content Editor, navigate to the item bucket that you want to revert to a normal container. 

2. On the Configure tab, in the Buckets group, click Revert. 

The item bucket reverts back to being a normal container and all of the sub-items are displayed 
as structured items. 

If you have lots of items stored in one bucket this may take some time. 
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Chapter 7  

Searching in Sitecore  

With the Sitecore search engine you are able to quickly search for items in Sitecore using 
advanced search functionality such as search filters and facets. 

This chapter contains the following sections: 

 Overview 

 Basic Searching 

 Pre-defined Search Options 

 Using Item Quick Actions 

 Using Special Characters in the Search Query 

 Filtering Search Results Using Facets 

 Search Filters 

 Performing Operations on Search Results 

 Saved Searches 



Sitecore CMS 7.1 Content Author's Reference and Cookbook  

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of 
this document are the property of Sitecore. Copyright © 2001-2013 Sitecore. All rights reserved.  

Page 105 of 188 

7.1 Overview 

The Sitecore search engine can be accessed from every item in the content tree in the Content Editor or 
from the ribbon in the Page Editor. In the Content Editor, item buckets open directly on the search tab, 
because you need the search functionality to find and open the items that are hidden in an item bucket. 

Note 
The administrator sets up the search engine and determines, for example, which search views and facets 
are available to you and whether or not you are able to see media items in the search results. 

7.1.1 Searching in the Content Editor 

In the Content Editor a search tab  is displayed next to the content tab of every item. When you click 
the search tab a new search tab opens displaying the time of the search. This gives you a nice reference 
to a specific search in case you open multiple search tabs or if you want to save a specific search. The 
search runs through the selected item only. 

After you run a search, the Search tab displays the following elements: 

 

Search Field 

In the search field, you enter the search query for your search. You can either enter free text or use pre-
defined search filters, or a combination of both. You can access the search options from the drop-down 
menu. 

Search Results 

When you run a search, the results are listed below the search field. The search results contain basic 
information about the items returned, such as title, template, and version to give you a quick overview. 
From the list of search results you can click an item to open it in a new tab in the editing pane.  
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View Types 

There are several ways to view the search results and these views are available to the right of the search 
field. Note that if you change view types, the search is run again based only on the text and filters in the 

search field. The default views are List view, Grid view, and Image view . If necessary, your 
administrator can activate several other views such as Tag view or Table view. 

Item Quick Actions 

There are a number of item quick actions available for each search result. These are shortcuts to the 
most common actions. For example, there is an item quick action that lets you publish an item directly 
from the list of search results. The Item Quick Actions are only available from a search you do from the 
Content Editor. 

Facets 

A facet is a way of categorizing the items returned by a search. The items can be classified by for 
example author, language, or when they were created. Once you have a list of search results you can 
use the facets to filter the results further. 

More Search Options 

If you click the down-down arrow to the left of the search field, you open a list of pre-defined search 
options that you can use to optimize and quicken your search. You can for example open an item from a 
list of the most recently modified or opened items, select one of the pre-defined search filters, or apply 
one of the search operations to all the items returned by the search. These options are all described in 
detail in the following sections. 

7.1.2 Searching in the Page Editor 

In the Page Editor, click the search icon  in the ribbon to open a search window. When the Navigate to 
Item dialog box opens, the search interface displays a list of all the content items.  

The Page Editor’s search interface is almost identical to the one in the Content Editor. The only difference 
is that, after you have searched for and found the item you would like to work on, you must select the item 
and then click OK to navigate to the item in the Page Editor. 
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7.2 Basic Searching 

To run a basic search: 

1. In the Content Editor, navigate to the item in the content tree from where you would like to run 
your search.  

2. For item buckets the Search tab opens by default.  

If you choose a different item, in the editing pane, click the Add a Search tab tab  to open a 
search tab.  

Note 
You can also launch a new search tab by right-clicking an item in the content tree and then 
clicking Search. 

3. In the Search field, enter the keyword you want to search for. 

Tip 
Enter * in the Search field and the search returns all the items within the item you have selected. 

4. Press Enter or click the search button and the search results are listed on the page. 

If you want to change the view of the search results, click one of the view icons to the right of the Search 
field. If you change the view, it launches the search again, based only on the keywords and filters in the 
Search field.  

7.2.1 Opening Items from the Search Results 

To open an item that appears in the search results, simply click the title of the search result and it opens 
in a new tab in the Content Editor.  
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You can also use the item quick actions in each search result to, for example, open the item in a specific 
language, in the Page Editor, or to lock it for editing. 

 

The options that are available in the item quick action bar are determined by the administrator. For more 
information about using the item quick actions, see the section Using Item Quick Actions 

Working with Multiple Tabs 

When you click an item in the list of search results, it opens on a new tab. This allows, you to work on one 
content item while having as many other tabs or items open in the editing pane as you need. For 
example, if you are working on several content items at the same time, you can now have them all open 
in the same editing pane. All the open tabs persist, even if you select a different item in the Content Tree. 

Sitecore also supports multiple search tabs, which means that you can open multiple content items from a 
search tab in the same editing pane, while keeping the first search results available.  

To open another Search tab, in the editing pane, click the Add a Search Tab  tab. 
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Managing Multiple Tabs 

When you are working with many tabs at the same time, Sitecore offers a quick way to close tabs, 
bookmark them, or refresh the content on a tab. Note that this functionality is only available on the search 
tabs that you open manually and are specified with a time stamp. You cannot use this functionality on the 
permanent Search tab that is displayed with an item bucket or the Content tab. 

To manage multiple tabs: 

1. Right-click a new search tab and a menu appears. 

 

2. The menu contains the following options: 

o Close All — closes all the extra search tabs. It does not close the Content tab or the 
permanent Search tab. 

o Close All But This — closes all the extra search tabs except from the current tab. 

o Close Tabs to Right — close all the extra search tabs to the right of the current tab. 

o Bookmark All — saves all open tabs in the Recent Tabs drop-down menu on the Search 
tab. 

o Refresh — refreshes the item in the tab. This is useful when an item has been modified, but 
the tab has not yet been updated. Use refresh if you, for example, add a new tag to the tag 
repository and you would like to use the new tag right away. 
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7.3 Pre-defined Search Options 

To ease the everyday work in Sitecore, the search functionality collects information on your recent search 
activity and which items have been created or modified recently. With these pre-defined search options 
you can quickly get to the items that you regularly work on regardless of which content item is selected in 
the content tree. 

 

The pre-defined search options include: 

 Your recent searches. 

 Recently modified items. 

 Recently created items. 

 Your recently opened tabs. 

To open items from a pre-defined search option: 

1. Click the drop-down arrow on the left side of the Search field. 

2. Expand one of the search options to see a detailed list of the content items that are listed for that 
specific search option.  

 

3. Click the link to a content item to open it in a new tab in the editing pane.  

However, if you click a search query under My Recent Searches the query is inserted in the 
search field, so that you can run the search again by clicking the search icon. You can enter more 
than one search query from My Recent Searches. 
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Note 
The default options that are available in the drop-down menu can be customized by your administrator. 
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7.4 Using Item Quick Actions 

When you have made a search, the list view displays the items with a number of item quick actions. 
These item quick actions are shortcuts to common tasks that you can perform when working with the 
items. 

Note 
The quick actions are only available in the Content Editor.  

In the following screenshot, you can for example lock or unlock the item for editing, create a new version, 
preview the item, or publish the item directly from the search tab. 

 

Note 
The administrator determines which item quick actions are available. The item quick actions are set up on 
the item itself or on the template that the item is based on. 

7.4.1 Manual and Dynamic Item Quick Actions 

An item can have item quick actions that are set manually by your administrator on for example the item’s 
template, or dynamic item quick actions that appear because of the nature or status of the item — a 
context aware item quick action.  

For example, in the following screenshot, the Sample Item has the Configure Standard Values item 
quick action.  

 

This item quick action is only relevant for template items. Another example is items that are part of a 
workflow for which there are item quick actions that you can use to push the items through the workflow. 
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7.5 Using Special Characters in the Search Query 

An item bucket can contain thousands of items, and it is therefore important for content authors to know 
how to make accurate searches and limit the search results to the most relevant items.  

As well as using quotation marks — “text” — to search for an exact word or phrase, Sitecore supports 
wildcards, replacements, and range searches.  

7.5.1 Wildcards and Replacements 

To help you search in Sitecore, you can use wildcards and replacements. The following symbols are 
supported by Sitecore and can be used in a basic search or within a pre-defined search filter as needed. 

 The * symbol is used to find every form of a word. You can use the symbol inside a word, at the 
beginning or end of the word, or a combination thereof. For example: 

o Searching for econom* will find "economy", "economics", “economical", and so on. 

o Searching for *graph* will find “paragraph”, “paragraphing”, “graphic”, and so on. 

o Using * by itself brings up all items within the item you have selected. 

 The ? symbol is used to replace any single character, either inside the word or at the beginning or 
end of the word. For example: 

o Searching for "t?re" will find "tire", "tyre", "tore", and so on. 

7.5.2 Searching within a Range 

If you need to search within a range, Sitecore supports both numerical and text range searches.  

For example: 

 price:[400 TO 500] 

 title:[algeria TO bahrain] 

Note 
A developer can add a slide control with a pre-defined range, which makes it easier for you to see and 
search within the accepted range. 
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7.6 Filtering Search Results Using Facets 

If your search gives too many results, you can quickly refine the search by using the facets that are 
available on the right of the search pane.  

 

A facet is a way of categorizing the items that are returned by a search. The items can be classified by for 
example author, language, or when it was created. There are several pre-defined facets and these can be 
applied directly to a content item, an item template, or to an item bucket by an administrator.  

When you run a search, a search on the facets is also performed. All the facets that have been applied to 
the items returned by the search are listed on the right of the Search page.  

Example: 

In the previous screenshot, the facets show that for the six results returned by the search, three are 
based on the news article template, four are in English, and all are created by the user sitecoreadmin. 

To sort the search results according to a facet, click a filter in the facet and the search results are filtered 
according to that facet. When you select a facet, it is marked in red and listed under Current Filters. 

In the following screenshot, the english and news article facets have been selected, and only two items 
match that filter. 
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To clear a facet and remove the filter from the search results, in the Current Filter facet, click the facet 
you want to remove.  
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7.7 Search Filters 

To limit the search results, you can insert one or more pre-defined search filters into the search field. 

 

To use search filters: 

1. Click the drop-down arrow on the left of the Search field. 

2. Expand the Search Filters option and select the required filter.  

The following search filters are available: 
 

Search Filters Description 

Search by Author Search for the items created by a specific author. 

Log Search (1 is on) Turn on logging for a single search query. This is only meant to 
be used by developers and administrators. 

Filter by Extension Search for items with a specific extension. This is useful when 
searching in the Media Library. 

Search by Language Search for items in a specific language. 

Search by Site Search for items on a specific site. Useful when you have 
multiple sites on the same Sitecore installation.   

Return Results Starting 
Date 

Search for items that were created on or after a specific date. 

Search by Template Search for items based on a specific template. 

Search by Version Search for items with a specific version number. 
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Search Filters Description 

Search by a Field Value Search for items with a specific value in a specific field. For 
example, to search for all the items that have the word design 
in the Title field, enter custom:title|design. 

Return Results up to 
Date 

Search for items that were created on or before a specific date. 

Search by ID (Max 1 
Result) 

Search for an item with a specific Item ID. You must enter the 
whole ID. 

Set Search Start Point 
(ID) 

Search for items from a specific location. Enter the specific 
content item ID where you want to start the search. 

Sort by Field Sorts the items based on the text in the field specified after the 
colon. For example, to sort the search results by item name 
you enter sort:_name. Click the sorting icon to revert the 
sorting. 

Search by Tag Search for items that have a specific tag. 

Search by Raw Text Search for items that contain a specific word.  

3. The filter is then inserted into the Search field followed by a colon. After the colon, enter the 
search keyword for the filter. Sitecore auto-suggests the text or prompts you to enter a date. You 
must enter 1-3 characters before Sitecore makes any suggestions. 

 

4. Press ENTER or click the Search button . 

Note 
Once you get familiar with the syntax for the different searches, you can type the search filter directly into 
the Search field, for example author:, template:, or start:. Sitecore still auto-suggests the text or prompts 
you to enter a date.  

7.7.1 Combining Multiple Search Filters 

You can combine multiple search filters to limit the search results even further and you can enter as many 
search filters as you need. 

When you enter more than one search filter the search uses or logic by default. This means that the 
search returns items based on either the first filter or items based on one or more of the remaining search 
filters. 
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For example, in the following screenshot, a filter for version 2 and a filter for the Japanese language are 
inserted in the search query.  

 

This returns two items — one item that has a version 2 and one item in Japanese. Neither of the search 
results matches both search filters. 

If the query gets too big, the filters collapse but it still gives you with an overview of the search filters. 

 

Combining And and Not in a Search Query 

To Perform complex searches for items that, for example, must contain or must exclude specific words, 
you must use and, or, and not to combine the search filters in the query.  

When you enter a filter in the search field, you can click the icon for the search filter and toggle between 
must contain  and must not contain .  

 If you select , the items that the search returns must contain the value in the search filter.  

 If you choose , the items that the search returns must not contain the filter value.  

 If you choose to add neither  or  to a search filter in a query with filters that are marked with 
either  or , the search filter with no marking determines which items are listed at the top of the 
search results. 
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In the previous example, the search results must have the text new in the content, the results cannot be 
in the English language, and the items written by the sitecoreadmin user are listed at the top of the search 
results. 
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7.8 Performing Operations on Search Results 

Search operations is a powerful feature that lets you run any operation on the search results. When you 
click Search Operations, a drop-down menu appears with several operations that you can perform on 
the results of the current search query.  

The operations listed in this screenshot are the default search operations in Sitecore, but your 
administrator can create and add customized search operations. 

 

To apply search operation to the search results: 

1. After you have generated a list of search results, click the drop-down arrow to the left of the 
Search field. 

2. Expand Search Operations and select the operation that you want to apply to the search results.  

Depending on your access right, only some of the following operations are available. For a user 
with full access rights, the following search operations are available: 
 

Search 
Operation 

Description 

Add Tag Tag all the items in the search results with the same tag.  
To add tags to the items in the search result, click Add Tag and the 
Item browser dialog box opens. Find the tag you want to add to items 
in the search result, either from the Items option, where you can 
navigate to the tag in the content tree or from the Search option, where 
you can use the search interface to find the tag.  
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Search 
Operation 

Description 

Search And 
Replace 

Replace a specific word in all the search result items with another word. 
When you click Search and Replace a dialog box appears. Enter the 
word you would like to replace, then enter a pipe ‘|’ followed by the 
word you want to insert instead. For example to replace the words 
‘Office Core’ with ‘Sitecore’, enter: Office Core|Sitecore in the text field.  

Note  
The search and replace functionality is case-sensitive. If you need to 
replace multiple words like ‘Office Core’, they are not replaced when 
they are joined by for example a hyphen — Office-Core.  

Clone 
Results To 

Clone all the items in the search results to a specific location in the 
content tree. When you click Clone Results To, the Clone Item dialog 
box opens. Here you specify the location for the new clones. You can 
either browse to the location through the content tree on the Browse 
tab or click the Search tab to search for the location.  

Delete 
Results 

Delete the items that appear in the search result. When you click 
Delete Results, the items are instantly deleted from Sitecore and a 
message appears telling you that the items have been deleted.  

Warning 
You are not presented with a warning or asked to confirm your choice 
before the items are deleted. Once you click Delete Results, all the 
search results are deleted from Sitecore completely and you are not 
able to restore them from the Recycle Bin. 

Publish 
Items 

Publish all the items in the search result at the same time. When the 
publishing job is finished, a message appears telling you that the items 
have been published. 

Apply 
Campaigns 
Goals 
Events to All 
Items 

Apply campaigns, events, or failure actions to the items in the search 
result. When you click Apply Campaigns Goals Events To the 
Attributes window opens from where you can specify the campaigns, 
events, failure actions, and settings for all the items in the search result.  
For more information about Sitecore campaigns, see the manual 
Marketing Operations Cookbook. 

Apply 
Presentation 
To All Items 

When you click Apply Presentation To All Items the Layout Details 
window opens. From here you can assign the same layout, controls, 
and placeholders to all the items in the search result. 

Copy to 
Datasource 
Query 

Create a text string that you can then paste into a “data source” field, so 
that the data source returns the items that match this search result. 
This operation is only relevant for developers and administrators. 

Apply 
Security 
Rule 

This operation should only be performed by security administrators. It 
allows them to change the security settings for the content items listed 
in the search results. When you click Apply Security Rules the 
Security Settings windows opens from where you can assign access 
rights to all the items in the search result for either a specific user or a 
specific role.  



Sitecore CMS 7.1 Content Author's Reference and Cookbook  

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of 
this document are the property of Sitecore. Copyright © 2001-2013 Sitecore. All rights reserved.  

Page 122 of 188 

Search 
Operation 

Description 

Copy 
Results To 

Copy all the items in the search result to another folder. When you click 
Copy Results To, the Copy Item To dialog box opens, from where you 
can browse to or search for the folder that you want to copy the items 
to. 

Move 
Results To 

Move all the items in the search result to another folder. When you click 
Move Results To, the Move Item To dialog box opens, from where 
you can browse to or search for the folder that you want to move the 
items to. 

Serialize 
Items 

Serialize all the items in the search results to files in the standard 
serialized files folder. When serializing an item, it is converted into a 
format that can be written into a file and imported again later into this or 
another Sitecore installation. When the operation is finished, a 
message appears telling you that the items have been serialized. 

Apply Profile 
Score To All 
Items 

Assign a profile card or a custom profile score to the items listed in the 
search result. When you click Apply Profile Score To All Items the 
Profile cards window opens from where you can select a profile card 
or set a customized profile score for the items in the search result. 
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7.9 Saved Searches 

If you have a search query that you run regularly from the same item bucket, you might consider creating 
a saved search. A saved search allows you to save and run a specific search query within an item bucket 
without having to enter the filters every time. 

Note 
Although content authors do have the necessary access rights to set up saved searches that are unique 
to themselves, we recommend that an administrator sets up the saved searches. The administrator can 
choose whether the saved searches should be unique to each user or not. 

To create a saved search: 

1. In the content tree, navigate to the item bucket that you want to search in. 

2. On the Home tab, in the Insert group, click Saved Search. 

3. Give the saved search a suitable name and it is added to the content tree as a sub item of the 
item bucket.  

4. Select the saved search item and on the Content tab scroll down to the Item Buckets section. 

 

You can build: 

o A Default bucket query — a query that appears in the search field every time you open the 
search tab, and you have the option to delete it from the search box if necessary. The default 
query is ‘text:*’, which brings back everything. 

o A Persistent bucket filter — a query that appears in the search field every time you open it, 
but you cannot delete it from the search field. The default query consists of the ‘location:{ID of 
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the parent item}’ which states the location from where the search should be run and the ‘-
template:{ID of the saved search template}’ which states that items based on the saved 
search template should not be displayed. 

5. Click the Build Query button to build the query from the search interface and click OK.  

As an example, the search query in the screenshot below consists of the persistent bucket filters 
for location and template, but you can enter as many filters as you need.  

 

6. To remove any queries from the Default Bucket Query or the Persistent Bucket Filter fields, 
click the Clear button. 

7. Click Save in the Content Editor ribbon to save your changes.  

7.9.1 Run a Saved Search 

Once you have saved a search, you can run it by clicking it in the content tree. 

To run a saved search: 

1. In the content tree, navigate to the saved search. 
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2. Click the saved search and it opens on the Search tab with the result of the pre-defined search 
criteria.  

 

The search field in the previous screenshot contains the following pre-defined search filters as 
described in section 7.9:  

o The first filter returns everything from the item bucket. Because the filter is part of the default 
bucket query you can click the X and remove the filter from the query.  

o The icon  in the second filter tells the search not to bring back any items based on the 
specific template ID. Furthermore, you cannot remove the filter from the query because it is 
part of the persistent bucket filter.  

o The third filter specifies the location ID from where the search should begin. This filter is also 
part of the persistent bucket query, which is why you are not able to remove it from the 
search query. 
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Chapter 8  

The Media Library 

This chapter describes the Sitecore Media Library and the functionality that it includes. It 
describes how you can use the Media Library to upload and edit different types of media 
items such as images, audio, and video. It also covers other more advanced options such 
as versioning. 

This chapter contains the following sections: 

 Overview 

 The Media Library User Interface 

 Uploading Media Files 

 Editing Media Items 

 Media Items and Versioning 

 Media Library and Searching 
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8.1 Overview 

You use the Media Library to store all the media files that you want to use on your website. You can 
embed media files, such as images, in a web page or make them available for download by visitors to 
your website. 

The Media Library can contain: 

 Images — .jpg, .gif, .png and other formats. 

 Word documents — .doc and .docx files. 

 PDF documents 

 Videos — .MPEG, .WMV and other formats. 

 Audio files — .MP3 and other audio formats. 

Sitecore has an Image Editor that you can use to edit images. 

The Media Library allows you to: 

 Keep all your media files in one place and organize them in a folder structure similar to the 
content tree. 

 Navigate the content tree or use Sitecore’s search functionality to quickly find media items. For 
more information on Sitecore’s search functionality, see the section Searching in Sitecore. 

 Upload media files to the Media Library. You can use the upload buttons to browse your 
computer for images or simple use the drag and drop dialog box to add media files. 

 Make every media content item and media file versionable. For more information about media 
items and versioning, see the section Media Items and Versioning. 

8.1.1 Opening the Media Library 

There are a number of ways to open the Media Library: 

Content Editor 

1. Log in to the Sitecore Desktop. 

2. Click the Sitecore menu, and then click Content Editor. 

3. In the Content Editor content tree, click the Media Library node.  

Alternatively, in the bar at the bottom of the Content Editor, click Media Library. 

 

Sitecore Menu 

1. Log in to Sitecore as admin and select Desktop. 

2. Click the Sitecore menu, and then click Media Library. 
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8.2 The Media Library User Interface 

The Media Library opens by default on the Search tab, with a search already run for all items in the 
Media Library. 

 

The Media Library Folder tab consists of the following elements: 
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The Ribbon 

In the Media Library, you get the same set of options in the ribbon as you do in the Content Editor, 
although the Insert group allows you to create new media folders and upload media files.  

If you select a media item in the content tree, the Media tab is displayed, which gives you two further 
groups of actions: 

 Write — Save changes 

 Media — View, Edit, Download, Drag & Drop 

Note 
The functionality in the ribbon depends on the user rights you have been assigned by the website 
administrator.  

The Content Tree 

Use the content tree or the search box to find media items. Expand nodes in the content tree to see all 
sub-folders and close nodes to hide sub-folders. 

You can view the Media Library content tree from the Content Editor or the Media Library. 

Search 

When you open the Media Library it opens by default on the Search tab with an already run search for all 
items in the Media Library. The Search tab offers an elaborate search functionality that can help you find 
very specific items among maybe thousands of items in the Media Library. 

For more information about the Sitecore search functionality, see the section Searching in Sitecore. 

Folders 

The Folder tab displays the options and media contents for a selected folder in the Media Library.  

You should store all your media items in folders and give folders meaningful names.  

An easy way to organize your Media Library folder structure is to mirror the structure of your website. For 
example, if your site has four main sections; Home, Products, Jobs and Contact Us you could create four 
folders with the same names to store all your images and other media. This will make it easier to locate 
media items as your site grows and you need to update media items. 

8.2.1 Creating New Folders in the Media Library 

You can create new folders in the Media Library content tree and you can add further sub-folders if you 
wish to keep your folder structure as simple and uncluttered as possible. 

To create a new folder: 

1. Select the Media Library item in the content tree or another item under which you would like to 
create a sub-item. 

2. On the Folder tab in the Options pane, click New Folder. 

3. Give the new folder a name and click OK. 

4. Select the new folder and you can see the Options section displayed in the Folder tab. The new 
folder has the same upload options as the other Media Library folders. 

Now you can start uploading media items to the new folder. 
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8.3 Uploading Media Files 

In the Media Library, there are three different ways to upload media files: 

 Upload Files 

 Upload Files (Advanced) 

 Drag & Drop 

8.3.1 Upload Files 

Use the Upload Files button to add single or multiple files to the Media Library. 

To upload a single media file: 

1. In the Media Library, in the content tree, select a destination folder. 

2. In the right-hand pane, in the Options section, click Upload Files. 

 

3. In the Select Files to Upload dialog box, browse to an image folder on your computer, and 
select the file that you want to upload. 

 



Sitecore CMS 7.1 Content Author's Reference and Cookbook  

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of 
this document are the property of Sitecore. Copyright © 2001-2013 Sitecore. All rights reserved.  

Page 131 of 188 

4. Click Open. 

During the upload process the following information is displayed: 

 

5. When the upload is complete, the image is displayed in the destination folder in the Media 
Library. 

8.3.2 Upload Files (Advanced) 

Use the Upload (Advanced) button to upload single or multiple media files to the Media Library. With the 
advanced upload option, you have a range of upload options available. For example you can choose to 
overwrite duplicates or make the uploaded media files versionable. 

To upload multiple files: 

1. In the Media Library, in the content tree, select the destination folder. 

2. In the right-hand pane, in the Options section, click Upload Files (Advanced). 

 

3. In the Select Files to Upload dialog box, browse to the folder on your computer that contains the 
images you want to upload.  
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To select multiple files, press the CTRL key while you select the files. 

4. Click Open. 

5. Before the upload process can start, the following dialog box is displayed: 

 

This dialog box contains the following information and additional upload options: 
 

Field Description 

Filename Displays a list of the files to upload — file name and 
extension, such as, jpeg, gif, or png. 

Size Displays the size of each file in kilobytes. 

Alternate Text Enter an alternative description here if you are 
uploading an image.  

Unpack Zip Archives Select this option if you upload a Zip archive and 
want to unpack the files in the Media Library. 

Overwrite Existing 
Media Items 

Select this option if you upload a file with the same 
name as a file that already exists in the Media 
Library, and want to overwrite the existing file. 
If you don’t select this option, a duplicate file is 
created in the Media Library. 

Make Uploaded Media 
Items Versionable 
 

Select this option if you want to make the file you are 
uploading versionable. If you don’t select this option, 
versioning remains switched off. 

Upload as Files 
 

Select this option to store the file in the file system 
rather than in the database. 

6. Click Upload. 

The uploaded images are displayed in the destination folder in the Media Library. 
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To Upload Multiple Files in a Batch 

1. Create a .zip archive on your local computer with the files you want to upload. You can include 

sub-folders with files.  

The folder structure is recreated in the Media Library after the files are extracted. 

2. In the Media Library, select the folder that you want to upload the files to. 

3. In the right-hand pane, click the Folder tab and then click Upload Files (Advanced). 

4. In the Select Files to Upload dialog box, browse to the .zip archive. 

5. Click Open. 

6. Select the Unpack ZIP archives checkbox. 

 

7. Click Upload. 

The archive is uploaded and extracted to the Media Library folder you selected. 
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8.3.3 Uploading Files with Drag and Drop 

You can also use drag and drop to upload files to the Media Library. Drag and drop is the quickest and 
easiest way to upload media files to the Media Library. You can upload single or multiple files from your 
computer to the Drag and Drop dialog box. 

 

To drag and drop files to the Media Library: 

1. In a Media Library, select the folder that you want to upload the files to. 

2. In the Folder tab, click Drag & Drop to open the Drag and Drop dialog box. 

 

3. Open Windows Explorer. 
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4. In Windows Explorer, navigate to the folder where the images are stored and select the images 
you want to upload. 

 

5. Position the Windows Explorer window next to the Drag and Drop dialog box and drag the 
selected images from Windows Explorer to the Drag and Drop dialog box. 

 

Note 
You have additional options to manage your media items in the Drag & Drop dialog box by right-
clicking an item. However, it is recommended to primarily manage and organize the media items 
from the Media Library. 

6. When you have dragged and dropped the files, click Done and they are copied to the Media 
Library. 



Sitecore CMS 7.1 Content Author's Reference and Cookbook  

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of 
this document are the property of Sitecore. Copyright © 2001-2013 Sitecore. All rights reserved.  

Page 136 of 188 

7. If the folder you copy to already contains the same media items, the Copy File dialog box opens, 
asking you to decide how to handle the duplicate media items. 

  

8. In the Media Library, Media section, you can now see the images that you uploaded and that 
each item contains a warning. 

 

9. Open the media item for each image and enter some text in the Alt field. This removes the 
warning from each item. 

Note 
Drag and drop functionality is currently only supported in Internet Explorer 7 or later. If you use a different 
browser such as Mozilla Firefox, you can only use the Upload Files and Upload Files (Advanced) options 
to upload files to the Media Library. 
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8.4 Editing Media Items 

In the Media Library, you can edit media items such as images, documents and videos either using 
Sitecore tools such as the Image Editor for images or with other applications that you have installed on 
your computer such as Microsoft Word for documents or Photoshop for images. 

8.4.1 Media Files and Media Items 

Before we start to edit a media item, it is important to understand the difference between media files and 
media items. An image stored in My Pictures on your computer is called a media file. If you upload an 
image file from here to the Sitecore Media Library, it is attached to a media item and from then on is 
referred to as a media item. 

In Sitecore, a media item is just another content item that is composed of several fields and always has a 
file attached to the Media field. To view a media item, click one of the images you uploaded earlier. 

A Sitecore media item: 

 

8.4.2 The Image Editor 

To open an image for editing in the Image Editor: 

1. Click the Sitecore menu. 

2. Click All Applications and then click Image Editor. 

3. In the Image Editor window, click Open to open the Media Browser window and select an 
image. 
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The Media Browser 

In the Media Browser window, you can view all the media items in the Media Library. You can expand or 
contract nodes in the Media Library content tree to find the media item you want to edit.  

You can access the Media Browser from the Content Editor. In a content item, in an Image field, click 
Browse to open the Media Browser window. 

 

8.4.3 Editing Options 

You can also edit media items locally on your computer. For example, you may prefer to use another 
application to edit images and then upload them again to the Media Library. 

When you click on a media item, the Edit icon in the Media group changes depending on the type of file 
you want to edit. For example, if you click a Word document, you see a pencil as the associated icon. 

 

If you click on an image, you see an artist’s palette. 
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If you select an image item and then click the top half of the Edit command, you open the image in the 
Sitecore Image Editor by default.  

 

You can change the default setting and use a different image editing program. 

To change you default image editor: 

1. In the Media Library, click the Sitecore button  and then click Application Options. 

 

2. In the Application Options dialog box, click the Media tab. 

3. In the Media Edit Button Default section, select the Open editing application installed on 
user’s computer check box.  

4. Click OK to save your changes. 

In the Media group, click the Edit arrow and a drop-down list appears.  

 

 Edit in Image Editor 
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 Edit in Local Editor 

These options allow you to override the default setting and select which editor you prefer to use. 

8.4.4 Using Drag and Drop to Edit Media Items 

You can also use the Drag & Drop dialog box to select a file and edit it. 

However, there are some application options that control how files are displayed and how editing works in 
the Drag & Drop dialog box. 

The Drag & Drop Application Options 

To set the Drag & Drop application options: 

1. In the Media Library, click the Sitecore menu, and then click Application Options. 

 

2. In the Application Options dialog box, click the Media tab.  

3. In the Drag & Drop section, you can specify the display settings for the Drag and Drop dialog 
box.  

There are two options: 

o Show only latest version of files 

If you select this option: 

The Drag & Drop dialog box only displays the latest version of each media file. 

When you open the Drag and Drop dialog box and delete the latest version of a media file 
from there, every version of the file is deleted. 

When you open the Drag & Drop dialog box and edit a media file from there, a new version 
of the file is automatically created when you save your changes. 

o Show versioned files in folders 

If you select this option: 

The Drag and Drop dialog box displays every version of the file in a folder. Different folders 
are created for each language that your website uses.  
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When you open the Drag and Drop dialog box and delete a version of a media file, Sitecore 
only deletes that version of the file. 

When you open the Drag and Drop dialog box and edit a media item, you must click Save 
As to create a new version of the item. 

4. In the Media Edit Button Default section, you specify which applications should be used to edit 
media files. 

If you select the Open editing application installed on user’s computer check box, Sitecore 
uses the local image editing application that is associated with the different image file extensions 
on your computer. This is the default setting. 

If you clear this check box, the Sitecore Image Editor is used. 

For more information about Drag and Drop and versioning, see the section, Making Drag and Drop Files 
Versionable. 

Editing Files from Drag & Drop Window 

You can also edit media items from the Drag & Drop dialog box. 

1. Select a media folder and then open the Drag & Drop dialog box.  

2. In the Drag & Drop dialog box, select the image you want to edit. 

3. Right-click the image, click Open With and then select an image editing application from the 
menu displayed. 

4. The image opens in the image editing program. 

5. Edit the image and save your changes in the editing application. 

If you click Save, the original image file is overwritten. 

If you click Save As, you create a new image in the Drag & Drop dialog box. You do not have to 
upload the file again. All the changes you make to the image are saved in the Drag & Drop 
dialog box. 

6. In the Drag & Drop dialog box, click Done. 
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8.5 Media Items and Versioning 

In Sitecore, a website consists of multiple content items. Each content item is made up of fields which 
contain content such as text or images. The Media Library contains media items. Media items are just 
another kind of content item. However, media items have an additional field called Media which has an 
attached media file. 

You can create multiple versions of any content item or media item. There are two types of versions you 
can create: 

 Numbered versions 
For example, you could create a second version of your products page that is to be used during a 
special promotion for a limited period. You could crop an image especially for this promotion and 
then revert back to the original image afterwards. 

 Language versions 
For example, you could create a page in Danish and then create a second version in English. 
You would therefore want an image to display Alt text in both languages. 

As stated earlier, versioning can be applied to content items and media items in the same way. However, 
media files that you upload to the Media Library can also be made versionable. 

Note 
There is no limit to the number of versions you can create in Sitecore. 

8.5.1 Versioned Media Items and Versioned Media Files 

In Sitecore, there is an important difference between versioning media items and versioning media files. 
The following scenarios explain the difference: 

Scenario 1 

You have a media item called diver. In the Content Editor, you click the Versions tab and make a second 
version of this item. 

The image file attached to the Media field (diver.jpg) in this item is not versionable by default.  

You want to create a second version of this item with different Alt text for your company’s spring 
promotion. The attached media file, diver.jpg is not versionable, so it remains unchanged when you 

create the new version. Only the information contained in item fields can be changed. Regardless of how 
many versions of this item you create, the attached media file (diver.jpg) remains unchanged. 

Scenario 2 

You have a media item called diver.jpg. In this scenario, before you upload the file to the Media 

Library, you decide to make it versionable. To do this, in the Upload Files (Advanced) dialog box, select 
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the Make Uploaded Media Items Versionable check box. 

 

Now when you create a second version of the item you can also keep any changes you make to the 
media file. For example, if you crop or edit the image you can create a second version each time you 
make a change to the file. 

Note 
When you upload new media files to the Media Library, they are unversioned by default. 

8.5.2 Creating a Second Numbered Version of a Media Item 

To make a second numbered version of a media item: 

1. In the Media Library content tree, select a media item. 

2. Click the Versions tab and in the Versions group, click Add, to add a new version. 

In the top right of the diver media item, you can now see a number 2. This is the number of the 
new version of the item that you created. 
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To switch between versions: 

1. Click the drop-down menu next to the version number and all versions of the selected item are 
displayed. 

 

2. Click the version number you want to view. 

Both numbered and language versions are displayed here. 

You can also click the Versions command in the Versions group to view different versions. 

8.5.3 Working with Versionable Media Files 

Media files that you upload to the Media Library are not versionable by default. However, media files can 
be made versionable after you have uploaded them to the Media Library.  

Why make media files versionable? When you edit an image, you may want the option to revert back to 
an older version of the image. 

There are two ways you can make a media file versionable:  

 Drag & Drop 

 Upload Files (Advanced)  

Making Drag and Drop Files Versionable 

To make all the media files that you upload to the Drop & Drag dialog box versionable: 

1. Open the Media Library. 

2. Click the Sitecore button and then click Application Options. 

3.  In the Application Options dialog box click the Drag & Drop tab and select the Show only 
latest version of files option.  

You must also change a configuration setting in the web.config file.  

1. The web.config file is stored in the web root folder of your website: 
C:\Inetpub\wwwroot\YourSitecoreWebsite\Website 

2. Right-click the web.config file, click Open With, and then click Notepad. 

3. Locate the following setting:  

<setting name="Media.UploadAsVersionableByDefault" value="false" />  
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To make every media file that you upload with the Drag & Drop functionality versionable, set this 
value to true. The default setting is false. 

4. Save your changes and close the web.config file. 

Changing this setting in the web.config file makes every file that you upload to the Drag & Drop dialog 

box versionable. 

The way the Drag & Drop dialog box functions and displays media files is determined by the application 
options you select in the Application Options dialog box. 

For information about the Drag & Drop application options, see the section The Drag & Drop Application 
Options. 

Using Upload Files (Advanced) to Make Items Versionable 

1. In the Upload Files (Advanced) dialog box, select the Make Uploaded Media Files 
Versionable check box. 

 

2. Click Upload. 

This makes the files you are currently uploading versionable. You must select this check box every 
time you upload some files to the Media Library. 
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8.6 Media Library and Searching 

In the Media Library, you can use the Sitecore search engine to search through the Media Library. 
Furthermore it can be set up to be able to search for specific words within the uploaded files. Whether it is 
a PDF file, DOCX or DOC file, Sitecore can automatically index all the content to make it searchable if 
you have an appropriate IFilter installed on the machine where the indexing is done. To set this up you 
need to consult your Sitecore Developer. 

Note 
An IFilter is a plugin that allows the search engine to index various file formats so that they become 
searchable. Without an appropriate IFilter, contents of a media file cannot be parsed and indexed by the 
search engine. 

When you search in the Media Library, a few more facets, such as File Size, Image Dimensions, and File 
Type, are available and you can use these to further filter the search results.  
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Chapter 9  

RSS Feeds 

Sitecore supports RSS feeds. This chapter describes how to set up an RSS feed as well 
as how to subscribe to an RSS feed. 

There is also a description of the client RSS feeds that Sitecore users can subscribe to. 

This chapter contains the following sections: 

 RSS Feeds 

 Sitecore Client Feeds 

 Security and Client RSS Feeds 
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9.1 RSS Feeds 

An RSS (Really Simple Syndication) is a web feed that is used to publish frequently updated material — 
such as blogs, news headlines, audio, video, and so on — in a standardized format. An RSS feed can 
contain either the full text of the material or a summarized version, as well as metadata, such as, 
publishing dates, and authorship.  

RSS feeds allow publishers to syndicate content automatically. Conversely, website visitors can subscribe 
to these feeds and automatically receive updates from their favorite websites. 

Website visitor subscribes to a feed by clicking an RSS icon in a browser and this initiates the 
subscription process. The RSS reader checks the user's subscribed feeds regularly to see if there are any 
updates and then downloads the updates that it finds, and provides the website visitor with an interface to 
monitor and read the feeds. 

9.1.1 Setting Up an RSS Feed 

In Sitecore, you must use the Content Editor to set up an RSS feed. 

You typically create RSS feeds for content items that are updated regularly — such as news items and 
blogs. In this example, you create an RSS feed for a news item. 

Before you can create any RSS feeds, you must create a folder to store your feed items. 

To create a folder for feed items: 

1. In the Content Editor, in the content tree, select the Home item of the website. 

2. On the Home tab, in the Insert group, click the drop down arrow and select Insert from 
Template. 

3. Click the Browse tab and navigate to Templates/Common/Folder 

 



Sitecore CMS 7.1 Content Author's Reference and Cookbook  

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of 
this document are the property of Sitecore. Copyright © 2001-2013 Sitecore. All rights reserved.  

Page 149 of 188 

4. Give the new folder a name — RSS Feeds. 

Now that you have created a folder to store the RSS feeds in, you can create an RSS feed. 

To create an RSS feed in the Content Editor: 

1. In the Content Editor, select the RSS Feeds folder that you just created. 

2. On the Home tab, in the Insert group, click Insert from Template. 

 

3. In the Insert from Template dialog box, navigate to Templates/System/Feeds/, and select 

RSS Feed to create a feed based on this template. 

4. In the Item Name field, enter a name for the new feed — News RSS Feed. 
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5. Click Insert and the new feed item is created and opened in the Content Editor. 

 

The new feed displays a warning informing you that the feed is empty and that you must select an 
item to include in the feed. 

6. In the Items field, click Insert Link. 

7. In the Insert Sitecore Item dialog box, click Sitecore, Content, Home, and then select the News 
item. 

  

8. Click Insert item and the News item is included in the RSS feed. 

9. On the Content tab, in the Description field, enter a description of the RSS feed. 
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10. Save the new item. 

You have now created the News RSS Feed item. 

Now let’s think about what the feed should contain. The feed should not tell subscribers that the News 
item has been updated; it should contain information about news articles that are created or updated.  

Note 
You can only create an RSS feed to an item that has subitems. If you create an RSS feed to an item that 
does not have any subitems, Sitecore tells you that the feed is empty. 

The next step is to configure how the news articles are presented in the RSS feed. 

To configure how an RSS feed is presented: 

1. In the Content Editor, expand the News item and select one of its subitems. 

2. Click the Presentation tab. 

 

3. In the Presentation tab, in the Feeds group, click Design. 
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4. In the Feed Presentation dialog box, specify how the feed is presented to the user who 
subscribes to this RSS feed. 
 

Field Value 

Title Field The item field that you want to appear in the title of the feed. 

Body Field The item field that you want to appear in the body of the feed. 

Date Field The date field that you want to appear in the feed. This could 
be, for example, the date the item was created, updated, or 
the date from which the news applies. 

Preview A preview of the feed based on the selections above. 

5. When you have filled in these fields, click OK. 

In the Feeds group, you can see that the Design button now has a green check mark indicating 
that an RSS feed has been designed for this item. 

6. In the Content Editor, save your changes. 

Important 
This item and all the other items based on the same template are presented in the same way in the feed. 
If some of the subitems are based on a different template, you must also specify how those items should 
be presented in the feed. 

When you have configured how the feed should be presented, the RSS feed item should no longer 
display any warnings. 

Identifying the Template that an Item is Based On 

As a content author, you probably don’t have access to the template in Sitecore. In fact, you may not be 
aware of the templates that the content items are based on.  

But when you set up RSS feeds, it might be helpful to see which template the item is based on. This is 
because the way the items are presented in the RSS feed depends on the template that they are based 
on.  
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To see which template an item is based on: 

1. In the Content Editor, click the Sitecore button , and then click Application Options. 

 

2. In the Application Options dialog box, select the Quick Info Section option and click OK. 

3. In the Content Editor, select the item you are interested in. 

4. The Content pane should now display a section called Quick Info at the top of the item. 

5. Expand the Quick Info section. 

 

6. The Template field tells you which template the item is based on. If you click the link to the 
template Sitecore opens the template item. 

9.1.2 Creating a Link to the RSS Feed 

After you have defined the RSS feed, you must add a link to the parent content item so that users can 
subscribe to the feed.  
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To add a link to the content item: 

1. In the Content Editor, open the News item. 

2. Expand the Page Title and Text section and click Show Editor above the Text field. 

3. In the editor, enter some text for the link. 

 

4. Select this text and click the Insert Sitecore Link button . 

 

5. In the Insert a Link dialog box, on the Internal Link tab, navigate to the RSS feed item that you 
created earlier, or search for the RSS feed on the Search tab. 

6. Click Link to create the link. 

7. In the Content Editor, save your changes. 

For more information about the Sitecore search functionality, see the section Searching in Sitecore. 

Previewing the RSS Feed 

Now that you have created the RSS feed for the News item, you can preview it to ensure that it works 
and looks the way you want it to. 

To preview the RSS feed: 

1. In the Content Editor, open the News item. 

2. Click the Presentation tab and then, in the Preview group, click Preview. 

When the RSS feed works correctly, you can publish it on your website. 
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Note 
You must publish all the changes that you made before they can be made available on your website. 

9.1.3 Subscribing to an RSS Feed 

When a visitor logs on to the website they can easily subscribe to the RSS feed. 

To subscribe to the RSS feed: 

1. Open your website in Internet Explorer. 

2. Navigate to the item that you have created an RSS feed for — the News page. 

 

3. In the News page, click the Subscribe to an RSS Feed link to open a new page displaying the 
RSS feed. 
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4. In the RSS Feed page, click Subscribe to this feed. 

 

5. In the Subscribe to this Feed dialog box, give the feed a name and specify where you would like 
to save it. 

6. Click Subscribe to add the feed to your list of feeds. 

7. You have now subscribed to this feed. When you open your browser, you can click Favorites, 
Feeds, and then click the News RSS Feed to see a list of all the news items on this website. 
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9.2 Sitecore Client Feeds 

Sitecore also contains a number of client feeds that content authors and other users of Sitecore can 
subscribe to. 

Sitecore contains the following client feeds: 

 Content item feeds 

 Workflow feeds 

 Workflow state feeds 

All of these client feeds are dependent on the items in question being subject to workflows. 

For information about workflows, see the section Workflows for Content Editors. 

9.2.1 Item Feeds 

To be informed about any changes that are made to an item in Sitecore, you can subscribe to an RSS 
feed for that item. You can subscribe to a feed for any item in the Content Editor content tree. However 
the feed will only contain useful information if the template that the item is based on is subject to a 
workflow. 

To subscribe to a Sitecore item feed: 

1. In the Content Editor, navigate to the item that you are interested in. 

In this example, you are a HR manager who wants to ensure that the text in an item about a job 
vacancy is correct before it is published on your website. You therefore subscribe to an RSS feed 
for this particular item. 
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2. Click the Review tab, and then in the Proofing group, click Subscribe.  

 

3. In the web page that opens, click Subscribe to this feed and add this RSS feed to your 
favorites. 

As you can see the RSS feed does not contain very much information at the moment. However, if a 
content author edits the item and moves it through the workflow, the feed becomes much more 
informative. When the item is edited by a content author, a new version is created and placed in the Draft 
workflow state. 

After a couple of days, the HR manager decides to check the RSS feed. 



Sitecore CMS 7.1 Content Author's Reference and Cookbook  

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of 
this document are the property of Sitecore. Copyright © 2001-2013 Sitecore. All rights reserved.  

Page 159 of 188 

In Internet Explorer, in the Favorites panel, click the Feeds tab, and then click the link to the item feed.  

 

This web page contains some information about the item, including: 

 The name of the item. 

 Its current workflow state. 

 The workflow history of the item. 

 A table showing the differences between the new version and the old version of the item. 

It also contains some workflow commands that let you move the item through the workflow — if you have 
the appropriate permissions. 

Sitecore Workflow Feeds 

Sitecore also contains some workflow feeds that you can subscribe to. For more information on 
workflows, see the section Workflows for Content Editors. 

To subscribe to a workflow feed: 

1. Open the Workbox from the Sitecore Start menu. Alternatively you can open the Workbox from 
the Pages bar at the bottom of the Content Editor. 
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2. To subscribe to a workflow feed, click the RSS feed button to the right of the workflow. 

 

For more information on the Workbox, see the section The Workbox. 

This client feed keeps you up to date on the entire workflow and is useful for administrators and 
super users who have access to every workflow state that the workflow contains. 

 

3. To subscribe to a workflow state feed, click the RSS feed button for the workflow state.  
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This client feed keeps you up to date on this particular workflow state. This client feed is useful for 
content authors and managers who only have access to particular workflow states. 

 

Using the RSS Feeds 

When you have subscribed to a workflow feed, you can use the RSS Feed to perform the tasks that you 
have permission for. 
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For example, in the following feed: 

 

The user can: 

 Approve or reject the item. 

 Approve or reject the item and insert a comment. 

 Edit the item. 

If you click Reject & comment, the following page appears: 

 

Enter your comment and then click Reject to send the item back to the previous workflow state. 

Important 
You must select the Remember me check box on the Sitecore login page to perform these tasks without 
having to log in.  

If you haven’t selected the Remember me check box, you must log in before you are directed to the 
appropriate page.  
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9.3 Security and Client RSS Feeds 

RSS technology is designed so that users who follow an RSS link can come directly to the item specified 
in the URL of the RSS feed. Most RSS readers do not support authentication. This means that users who 
subscribe to Sitecore client RSS feeds have direct access to the item specified in the URL of the RSS 
feed and do not have to identify themselves to the Sitecore security system when they view the RSS 
feed. However, the Sitecore security system verifies that they are authorized users when they try to 
perform any actions associated with the client feed. 

If someone else gains access to the URL of the RSS feed: 

 They can follow the link and view all the content contained in the RSS feed even though their own 
security permissions do not give them access to this item. 

 They cannot perform any actions on the content.  

 They cannot view any other content.  

 They cannot gain access to the username or password of the original owner of the RSS feed. 

 They cannot modify the link to gain access to any other content. 

Important 
Sitecore users should not share RSS feeds.  

For more information about tightening security around RSS feeds, see the Sitecore Security Hardening 
Guide. 
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Chapter 10  

Workflows for Content Editors 

This chapter describes workflows, what you can use them for, and how they are 
implemented in Sitecore. There is also a description of the Workbox that reviewers use to 
move items through workflows. 

 Workflows 

 The Workbox 
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10.1 Workflows 

Workflows are a system that you can use in Sitecore to control when a content item is published. 

A workflow is a series of states that you define. These states should reflect the work processes and 
procedures that have been implemented in your organization for creating web content. These states can 
correspond to the creation, review, and approval stages that content items must go through before they 
are published on your website. 

Workflows are a way of formalizing and enforcing these processes and procedures to ensure that only 
content items that have been approved are published.  

A workflow can contain any number of different workflow states and be as simple or complex as required. 
Content items do not necessarily have to pass through all the workflow states that you have defined — 
some states can be optional or only applicable for certain kinds of content. 

Furthermore, you can implement any number of different workflows. Each workflow must as a minimum 
contain two workflow states, one that has been defined as the initial workflow state and one that has been 
defined as the final workflow state. 

Content items must pass through the appropriate workflow states and can only be published when they 
are in the final workflow state. 

10.1.1 Implementing Workflows 

Workflows are normally implemented by developers. It can however be useful for content authors to 
understand how they are constructed and implemented. 

Workflows consist of special items that are stored in the Sitecore content tree. 

A workflow consists of: 

A Workflow — the main item that contains all of the subitems that make up the workflow. 

Workflow States — the basic building blocks of the workflow. The workflow states represent the different 
stages in your content creation process. Content items that are sent through a workflow start in the initial 
workflow state and finish in the final workflow state. 

Workflow Commands — the actions that must be performed by the various contributors to move the 
content items from one workflow state to another. 

Workflow Actions — actions that are automatically performed on the content items when they are in 
particular workflow states or when particular workflow commands are executed. 



Sitecore CMS 7.1 Content Author's Reference and Cookbook  

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of 
this document are the property of Sitecore. Copyright © 2001-2013 Sitecore. All rights reserved.  

Page 166 of 188 

Here is an example of a workflow: 

 

After the workflow has been defined, the developer specifies which item templates are subject to the 
workflow. When they have done this, every time a content author creates or edits a content item that is 
based on one of these templates the content item is sent to the initial workflow state of this workflow.  

Important 
Content items can only be published when they are in the final workflow state. 

10.1.2 Using Workflows 

After the workflow has been implemented, content authors must send the content items they create or 
edit through the workflow before they can be published. 

When you create a new content item, it is automatically placed in the initial workflow state. The content 
item remains in the initial workflow state until you use a workflow command to move it to another workflow 
state. 

If you edit an existing content item that is subject to a workflow, Sitecore creates a new version of this 
content item and places it in the initial workflow state. If you edit this content item again later, you edit the 
version that is in the workflow unless you specify that you want to edit another version. 

Important 
Content items that are edited by administrators are not subject to workflows. 

Moving Items through a Workflow in the Page Editor 

When you have finished editing the content item, you can send it to the next workflow state. 

To send a content item to the next workflow state: 

1. In the Page Editor, navigate to the page you want to work on. 
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2. Edit the page and save your changes. If the page you are editing is part of a workflow, you will 
see all workflow commands in the Page Editor. 

 

In the Page Editor, there is a notification bar that displays a workflow command — Submit. This is 
the only workflow command that you can apply to the current page in its present workflow state. 

3. Click Submit to send the content item to the next workflow state. Sitecore displays a dialog box 
for you to enter a comment. 

 

4. Enter a comment and then the content item is moved to the next workflow state.  
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The workflow commands that are available in the Page Editor change to reflect the item’s new 
status. 

 

However, if you do not have permission to edit the content item in this workflow state, you cannot 
lock the item for editing and the workflow commands will not be displayed. 

Moving Items through a Workflow in the Content Editor 

When you have finished editing the content item, you can send it to the next workflow state. 

To send a content item to the next workflow state: 

1. In the Content Editor, open the content item that you are working on. 

2. When you are satisfied that it can be sent on through the workflow, click the Review tab. 

 

As you can see, the Workflow group displays a workflow command — Submit. This is the only 
workflow command that you can apply to the current content item in its present workflow state.  

Furthermore, the content item also displays a message informing you that this version of the item 
cannot be published because it is not in the final workflow state. 
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3. Click Submit to send the content item to the next workflow state. Sitecore displays a dialog box 
for you to enter a comment: 

 

4. Enter a comment and then the content item is moved to the next workflow state. 

The workflow commands that are available in the Workflow group change to reflect the item’s 
new status. 

 

However, if you do not have permission to edit the content item in this workflow state, you cannot 
lock the item for editing and the workflow commands will not be displayed. 

Sitecore also contains a Workbox that been designed to give reviewers a greater overview of all the 
content items that are currently in workflows. 
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10.2 The Workbox 

The Workbox is a tool for reviewers and managers and gives them the overview they need to perform 
their tasks. 

10.2.1 Using the Workbox 

When you need to review content items, you should use the Workbox to see all the content items that are 
currently in workflows and which workflow states they are in. 

To use the Workbox: 

1. Log in to the Sitecore Desktop. 

2. Click the Sitecore Start button and then Workbox. 

 

In the Workbox, you can see that the Sample Workflow has been selected and you can see all 
the relevant workflow states. You can also see that there is one content item in the Awaiting 
Approval workflow state. 

3. In every workflow state, you can preview, open, compare, each content item as well as apply the 
workflow commands that have been defined for that workflow state.  

In the Awaiting Approval workflow state, you can approve, or reject the content item. 

Previewing an Item 

To preview the version of a content item that is in a workflow state, click Preview and this version of the 
item is displayed in a new browser window.  

Opening an Item 

To open a content item, click Open and the item is opened in the Content Editor. 
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Comparing an Item 

To see the changes that have been made to a content item, click Diff.  

 

The Compare Versions dialog box lets you see the changes that have been made to this version of the 
item. You can select which versions to compare and whether you want them displayed in one or two 
columns. 

Approving or Rejecting an Item 

When you are finished reviewing the content item, click Approve or Reject to move it to the appropriate 
workflow state. 

10.2.2 Several Workflows 

If you have implemented more than one workflow, you can view them at the same time or switch between 
the different workflows in the Workbox. 

 

To display or hide a workflow in the Workbox, select or clear the check boxes in the Workflows group. 
You can also expand and collapse each workflow and workflow state. 
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Chapter 11  

Customizing the Interface 

You can change the interface in Sitecore. This chapter describes how to increase usable 
screen space, customize the interface in the Content Editor and in the Page Editor. There 
is also a description of how to customize the Sitecore Desktop. 

This chapter contains the following sections: 

 Working with the Browser 

 Customizing the Content Editor 

 Customizing the Page Editor 
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11.1 Working with the Browser 

All of the interfaces and programs that Sitecore contains are displayed in a normal web browser.  

11.1.1 Full Screen Mode 

If you need to see more of the web page or item that you are editing because there are too many 
elements in the way or because you are using a computer with a small screen, you can gain some space 
by expanding the browser interface to full screen mode. 

To enable full screen mode, press F11. This expands the browser window to fill the entire screen and 
hides the user interface elements of the browser — the title bar, menus, toolbar, and status bar. 

To see some of hidden user interface elements, move your mouse to the top of the screen. Press F11 
again to restore the hidden browser user interface elements and exit full screen mode. 

11.1.2 The Sitecore Desktop 

When you are using the Sitecore Desktop application you can change some of the settings that affect the 
way Sitecore looks and customize other settings to suit your needs. 

In the Sitecore Desktop, you can: 

 Change the desktop background. 

 Change your password. 

 Change the application options. 

 Change your personal information. 

 Change the language settings. 

Changing the Desktop Background 

You can change the image displayed as your desktop background when you log in to the Sitecore 
desktop. 

To change the desktop background: 

1. Log in to the Sitecore Desktop. 
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2. Click the Sitecore menu and then click Control Panel, Preferences. 

 

3. In the Preferences dialog box, click Change Your Desktop Background. 

 

4. In the Background field, select the image that you want to use. 

5. In the Position field, use the drop down arrow to select how you want to place the image on the 
desktop. 

6. In the Color field, select the color you want to surround the image if it does not fill the screen. 

Changing Your Password 

To change your password: 

1. In the Sitecore Desktop, click the Sitecore menu and then click Control Panel, Preferences. 
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2. In the Preferences dialog box, click Change Your Password. 

 

3. In the Change Password dialog box, enter your current password and then enter and confirm 
your new password. 

You can also change your password in the Sitecore log in page. 

 

Changing your Personal Information 

To change your personal information: 

1. In the Sitecore Desktop, click the Sitecore menu and then click Control Panel, Preferences. 

2. In the Preferences dialog box, click Change Your Personal Information. 

 

3. In the Personal Information dialog box, you can change your name, e-mail address, and the 
image that is used as your portrait throughout Sitecore. 
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Changing Your Regional and Language Options 

To change your regional and language options: 

1. In the Sitecore Desktop, click the Sitecore menu and then click Control Panel, Preferences. 

2. In the Preferences dialog box, click Set Your Regional and Language Options. 

 

3. In the Regional and Language Settings dialog box, you can: 

o Select the formats that you want to use for numbers, currencies, times, and dates. 

o Select the language that you want the client application to use. 

Using the Default Settings 

To use the default settings: 

1. In the Sitecore Desktop, click the Sitecore menu and then click Control Panel, Preferences. 

2. In the Preferences dialog box, click Reset My Settings to Default Values. 
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11.2 Customizing the Content Editor 

The Content Editor contains a number of user interface elements that you can. 

You can, for example, give yourself more room to work in by: 

 Customizing the ribbon. 

 Customizing the content tree. 

 Resizing the editing pane. 

11.2.1 Customizing the Ribbon 

There are several ways in which you can customize the ribbon. 

You can: 

 Hide the ribbon. 

 Hide the tabs. 

 Create your own toolbar 

Hiding the Ribbon 

To hide the ribbon in the Content Editor:  

1. Double-click any tab to hide the ribbon. 

 

The ribbon is removed but the tabs are still displayed. 

2. Click on a tab to open that tab and display the ribbon again. 

Hiding Tabs 

You can also specify which tabs are displayed in the Content Editor. 
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To hide a tab: 

1. Right-click anywhere on the ribbon to open a dialog box. 

 

2. Select or clear the check boxes to decide which tabs you want displayed in the Content Editor. 

3. Click reset to restore the default tab selection. 

Creating your own Toolbar 

You can also create your own toolbar that only contains the tools and functionality that you need to do 
your work. 

To create your own toolbar: 

1. Right-click anywhere on the ribbon and click Customize to open the Customize My Toolbar 
dialog box. 

 

2. In the All pane, expand the groups and select the commands that you want on your toolbar. 
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You can only select commands and not groups. You can however insert separators to divide 
them into groups and use the up and down arrows to place the commands in the order you want. 

 

3. When you are finished, click OK. 

4. Right-click on the ribbon to open the tabs dialog box and select the My Toolbar tab. The tab is 
added to the ribbon and contains all the command that you just selected. 

 

11.2.2 Customizing the Content Tree 

In the Content Editor, you can easily resize the content tree pane or hide the content tree entirely if you 
prefer. 

Hiding the Content Tree 

To hide the content tree: 

1. In the Content Editor, click the View tab. 

 

2. Clear the Content Tree check box to hide the content tree. 
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3. Clear the Entire Tree check box to hide the root of the content tree (sitecore) and the Media 
Library. This view ensures that users can only see the items that are part of their website. 

4. Clear the Hidden Items check box to hide some of the system items that are displayed in the 
content tree. 

The other two settings — Raw Values and Standard Fields are only relevant for administrators. 

Resizing the Content Tree 

You can also resize the content tree. This can be useful when you need to find an item or when the pane 
takes up too much space. 

To resize the content tree: 

1. In the Content Editor, move the mouse over the bar between the Content Tree and the Editing 
pane. 

2. Drag the bar to the left or right to resize the elements in the window. 

Configuring the Quick Action Bar 

The Quick Action Bar runs down the side of the content tree and can be used to display information that 
can be useful to both the content author and the administrator. 

 

To configure the Quick Action Bar: 

1. Right-click the Quick Action Bar to see a list of the elements that it can display. 

 

2. Click an item in the menu to hide or display an icon beside the item that is affected.  
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You can select the following items: 
 

Menu Item Tells you 

Item Buckets Which items are item buckets. 

Cloned Items Which items are clones. 

My Locked Items Which items you have locked. 

Locked Items Which items have been locked by another user and 
who locked it. 

Workflow State The workflow state of the item. 

Broken Links Which items contains broken links. 

Missing Versions Which items are missing a version. 

Published Warnings Which items have published warnings. 

Validation Rules Which items contain validation errors. 

Presentation Overridden Which items have the layout settings that are defined 
in the template they are based on overridden by 
another layout. 

Note 
The items that are available in this menu in your Sitecore solution may vary from the ones shown here. 
This is controlled by your Sitecore system administrator. 

You can select as many of these options as you like. There is a performance overhead to pay for each of 
these options. 

Important 
The Validation Rules and Broken Links options are the most costly of the Quick Action Bar options. Each 
time you open an item in the content tree the client must make a server call to refresh these options.  

11.2.3 Changing the Application Options 

When you are using the Content Editor, you can also specify which elements of the Content Editor 
application should be displayed. 

To configure the Content Editor: 

1. In the Content Editor, click on the Sitecore button in the top left-hand corner. 

 

Alternatively, in the Sitecore Desktop, click the Sitecore menu and then click Control Panel, 
Preferences. 
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2.  Click Application Options to open the Application Options dialog box. 

 

3. Select or clear any of the check boxes to hide or show the element in question. 

The following screenshot points out where most of these elements are found in the Content 
Editor: 
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The remaining elements in the Show/Hide section are: 
 

Section Field Description  

Show/Hide Bucket Items Display the otherwise hidden items in an item 
bucket in a folder structure. It is recommended to 
clear this check box, because it will prevent the 
system from unnecessarily loading all the items in 
the content tree.  

Fields from the Standard 
Template 

Display a large number of fields that are used 
internally by Sitecore. These are hidden to 
improve performance 

Use Smart Tags An alternate way to show the commands 
associated with a field. 

 

Prefetch Collapsed 
Sections 

The system fetches and keeps the fields from the 
Field Sections in memory before the section is 
even opened. 

Field Values Show Input Controls Shows the field values as input controls. This is 
only relevant for administrators. 

Show Raw Values Shows the field values as raw values. This is only 
relevant for administrators. 

Pages Show Pages Bar Determines whether or not the shortcuts to the 
Sitecore applications are displayed at the bottom 
of the Content Editor. 
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4. Click the View tab of the Application Options dialog box for more options on what should be 
viewed in the Content Editor.  

 
Section Field Description  

Content Tree – 
Item Names 

Display Name (language-
specific name) 

Select to show the language specific 
display name that you can give an 
item. 

Item Key Select to show the item key in the 
content tree. 

Content Tree 
Root 

Show the Content Tree in the 
Content Editor 

Show the content tree in the Content 
Editor. 

Show Entire Content Tree Show the entire content tree in the 
Content Editor. Clear the check box to 
show only the Content node in the 
content tree. 

Control Properties Show the Personalization 
Section 

To be used only in the Marketing 
Center. 

Show the Test Lab Section To be used only in the Marketing 
Center. 
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5. Click the Media tab for what should be showed in the Drag & Drop dialog or whether to open the 
editing application available on the user’s computer. 

 
Section Field Description  

Drag & Drop Show only latest version of files Select to show only the latest version 
of the media files in the Drag & Drop 
dialog box. 

Show versioned files in folders Select to show all versions of a media 
file in the Drag & Drop dialog box. 

Media Edit Button 
Default 

Open editing application 
installed on user’s computer. 

Open the media items with the editing 
application that is installed on the 
user’s computer. 

Setting the Display Name of an Item 

To set the display name of an item: 

1. In the Content Editor, select the item in the content tree. 

2. On the Home tab, in the Rename section, click Display Name. 

3. When you are prompted, enter the name that you want displayed in the dialog box that appears. 

4. Refresh the content tree and the display name is visible. 

 



Sitecore CMS 7.1 Content Author's Reference and Cookbook  

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of 
this document are the property of Sitecore. Copyright © 2001-2013 Sitecore. All rights reserved.  

Page 186 of 188 

In the Content pane, the key is shown after the display name. 

Furthermore, the display name is also used for the item in the published website. 
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11.3 Customizing the Page Editor 

You can customize the Page Editor. However, it has limited functionality available for you to change  

11.3.1 Working with the Ribbon 

The functionality that is available to you in the Page Editor is determined by the roles that your site 
administrator has assigned to you. 

Hiding the Ribbon 

If you only have limited access to the functionality contained in the Page Editor, you can hide the ribbon 
to give yourself more space to work with. 

To hide the ribbon: 

1. Log in to the Page Editor. 

 

2. Click the Toggle the ribbon button  at the top of the screen to hide the ribbon. 

3. When you need to use the ribbon, click Toggle the ribbon button  and it appears again. 

Changing the Interface 

If you have access to more functionality in the Page Editor, you can also change the way the Page Editor 
presents editable items to you. 

To change the interface: 

1. Log in to the Page Editor. 

 

2. In the Page Editor, click the View tab. 
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3. In the View tab: 

o To edit the page text, select the Editing check box. 

o To edit renderings and placeholders, select the Designing check box. 

o To show outlines of all the selectable objects on a page, select the Controls check box. Use 
this feature to understand how the page is organized. 

o To display the Navigation bar, select the Navigation bar check box. 


